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Manual Conventions

Dispensing system buttons, label's, switches or connections appear in
this text style.

Fluidmove for Windows (FMW) buttons and dialog boxes appear in
this text style.

All menu selections within FMW appear in this text style.

Fluidmove for DOS (FMDOS) windows, menu selections, and
commands appear in this text style.

The first occurrence of a glossary term appears underlined
The definition of the term occurs in the Glossary.

Filenames appear in THI S TEXT STYLE.

Typed commands, names and values appear int hi s t ext
styl e.

Level 1 Safety Warning. The information following this symbol
cautions you of actions that could cause minor bodily harm to the
user.

Level 2 Safety Warning. This symbol appears in a highlighted text
block. The information in the text block warns you of actions that
could cause serious bodily harm to the user.

Level 1 Machinery and Software Caution. The information following
this symbol cautions you about actions that could cause minor
damage to the machinery or software.

Level 2 Machinery and Software Caution. This symbol appears in a
highlighted text block. The information in the text block warns you
about actions that could cause serious damage to the machinery
or software.

This symbol appears next to atext block with helpful information
relating to text that precedesit, or information you must know before
proceeding.

This symbol appears next to atext block with atimesaving or
technique tip.

This symbol appears next to atext block with instructions for error
recovery.
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1 Getting Started

Welcome to Fluidmove for Windows (FMW). FMW is a true Windows™ software package
for automated fluid dispensing.

In most cases, FMW should arrive aready installed and configured for your dispensing
system. If you should need to re-install FMW refer to the Installation section of this manual.

The tutorials are designed to teach you specific programming techniques. The first lessons
teach basic elements used to build more complex patterns. Advanced lessons teach you how
to program entire workpieces and add process commands. The estimated time to successfully
complete each lesson is identified.

Supplied with this manua are Fluidmove for Windows Tutorial Boards which will be used
for the dispensing exercises.

,@5 NOTE This manua is intended for use with Fluidmove for Windows Release 2.7
or higher.
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2 Installation

In most cases, FMW arrives aready installed on and configured for your dispensing system from
the Asymtek factory. The installation processis atypica Windows installation with user prompits.

g NOTE Refer to this section for afirst time installation only. Upgraded versions of FMW
include their own ingtalation instructions.

The FMW Installation Package

The FMW Ingtallation Kit contains, at a minimum, the following components. Please check that
you have dl of them. If any part of the kit is missing, call Asymtek.

Fluidmove for Windows User Guide.

Fuidmove for Windows Tutoria Board, Quantity 5.

Fluidmove for Windows Diskette Envel ope containing installation diskettes.
FMW Dispensing Program diskette (optional).

FMWTools Instalation diskettes.

Y ou may have chosen an additional SECS/GEM Interface option which enables your system to
communicate with other production equipment, in which case a separate instdlation kit will also be
included.
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Setting up the Dispensing System for FMW Installation

Before you begin the installation procedure, make certain that your dispensing system is
operationa by following the checks below. Reference the dispensing system Operations Manual
for the location of indicated components or options.

1. Make certain that the dispensing system is ON by looking for the following indications.

» If abeaconis present, it should be ON and yellow or green. If the beacon is red,
close the dispensing system doors or press Reset on the Dispenser and Conveyor
Control panels.

» If abeacon is present, but not ON, or if there is no change after you turn the Main
Power switch or press the optional Start button, make certain that the Main Circuit
Breaker on the lower left side panel is ON, and that the system is plugged into an
electrical outlet. If the system is not plugged in, consult a service technician to plug
in the system.

» If no beacon is present, make sure that the Main Power switch on the front control
panel is ON and that the Interlock key isset to I

Set the Interlock to 1if possible, or call a service technician to set it for you.
Close the dispensing system doors, or clear the light curtain area

Make sure the Main Air is set to aminimum 70 ps.

Refer to the system Operations Manual for the location of al components.
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Installation Procedure

Most of the standard installation process is automated. Y ou will be prompted to insert disks,
approve file locations and accept defaults. Automatic backups are made for some files during
ingallation.

Since FMW is a true Windows software package, installing FMW follows standard Windows 3.X
instalation procedures. This procedure also includes ingtalation instructions for FMWTodls.

m CAUTION This installation procedure should be performed by an application engineer,
Information Systems manager or computer programmer.

m CAUTION Do NOT attempt to install FMW on Windows 95.

Toinstall FMW:

If any Windows programs are running, close them.

Insert FMW Ingtalation Disk 1 into Drive A of the dispensing system computer.
Open the Main program group by double clicking on it.

Open File Manager by double clicking on it.

Select Run from the File menu.

© g~ 0w NP

Type a:\setup.exe inthetext box and click on OK.

» Thelngalation Welcome screen will open.

g NOTE You can stop ingtallation at any time by choosing Cancel.

7. Follow the on-screen prompts.

» Contact Asymtek Technical Support for help if necessary.

Toinstall FMWTooals:;

Insert FMWTools Disk 1 into the A drive on the system compuiter.
On the Program Manager menu bar, select File, then select Run.

Type a:\setup.exe inthetext box and click on OK.

A WD e

Follow the on-screen prompts.

»  Contact Asymtek Technical Support if necessary.
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3 Tour of Fluidmove

Overview

This chapter tells you what tools and supplies you will need and guides you through basic
dispensing system setup procedures.

This chapter also provides atour of the unique Windowsa Graphic User Interface (GUI) of
FMW. Each window will be visited and explained in detail, along with al icons, toolbars and
message areas. After reading this chapter, you will be ready to start the programming
eXercises.

Estimated time to complete: 20 minutes

System Setup and Operation

To use FMW, it is necessary to make sure that your dispensing system isin a known ready
state. It is recommended that you refer to the Operations Manual for your dispensing system
for Start-up and Setup information that may be specific to your particular system.

Features

FMW was designed to smplify programming and testing of complex dispensing routines
requiring explicit machine and fluid controls. In addition, FMW can be used by a variety of
users, from process engineers to production operators. Menu access is restricted by
passwords, while enabling the user the flexibility needed to complete the job efficiently.

Some of the features which make FMW aflexible, easy-to-use, benchmark for dispensing
system software are briefly described below.

Advanced Vision System Support

Asymtek dispensing systems using FMW are equipped with an advanced camerallight vision
system called Asymtek Vision for Windows (AVW). This system is an integrated application
within FMW. It alows you to see the board onto which you are dispensing, and alows for
control of light levels, camera-offset, corner finding agorithms, fiducial recognition, skew
correction, chip tolerance and part skipping. FMW is capable of controlling these parameters,
alowing you to optimize them as necessary to perfect your dispensing process. A video
overlay of the board appearsin afully integrated FMW window.
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Simplified Setup/Configuration Routines

Dispensing systems are complex and must be calibrated with the process you are performing.
In addition, process programmers require a different setup procedure than a production
operator.

FMW alows you to set up programming options and preferences such as measurement,
workpiece alignment, fluid setup, operator and access levels from the Main Window. Also,
from this menu, a Master Offsets routine prompts you through initia system and software
calibration for the Height Sensor setup, Camera Offset, Purge Station and Weigh Station
locations, making initidization fast and easy. The Production Window aso has a Setup menu
designed for use by production operators. Manua setup options are aso available for specific
setup tasks, giving the operator quick control over all production functions.

Advanced Programming Menus

The Programming Window is specificaly designed to make programming intuitive and easy.
The programmer is prompted through workpiece and fiducia setup. Logical tool bars and
menu icons for common commands smplify keystrokes. In this window, the programmer has
access to al machine controls, fluid control parameters and timing parameters, and can use
them in the process program. Wet and dry dispensing runs can be performed in the
Programming Window.

SPC Data Logging

For production run statistics, FMW can collect board tracking data, production lot tracking,
flow rate calibration data and fluid ot data. The information is collected in an ASCII format
data file which can be read by the standard Windows 3.x and Windows 95 text reader
gpplication “Notepad’, or any editor program capable of opening ASCII files.

On-line Help

Like al true-Windows software packages, FMW has a standard On-line Help system
access ble from al menus and diaog boxes. Context-sensitive Help directs you to the help
topic associated with the current dialog box. The On-line Help Topics include General Help
for FMW, on-line Tutorids, and alist of al Automove Control Language (ACL) Commands.
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User Interface

You will find that the FMW user interface was designed to utilize the smplicity and
intuitiveness of Windows-based software. Upon instalation, FMW creates two program
groups. FMW and Cognex™™ Vision Processor. Depending on the options installed on your
dispensing system, one or two additional program groups are also created: one Video
Blaster™ or two Matrox' ™.,

Regardless of system configuration, the following program groups are created upon

installation;

Fhwi2. 7

ASYMTEK FMW 2.6

uog g &2 8

Heater Frw Help Heater Help  Dizspense.Out Feadme

M5-0a5
Prarmpt

B

1l

Frivtonls 2.7

= CognexYisionProcessor < | -
& W W

Wintalk 7.4 Wi Cloge AllWxD Wigioh
Handlez Procezsor
Config 7.4
Figure 3-1

If your system configuration includes a Video Blaster, the following additional program group

is also created:

= Video Blaster SE100 -~

4 & 4

Wideo Kit Yideo Blaster Read Me  Releaze Maotes VPw Drivers

SE100 SE100 Setup Releaze Motes

Figure 3-2
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If your system configuration includes a Matrox card, the following additiona program groups

are created:

B MGA PowerDesk B
A

MGAVideo  Readmeil
Prezentation

= MGA Millennium PowerDesk
= I

ZETY

Board Mnnitnlr Contral F;anel Guick Access MGA
| mformation Selection Uninztallation
Figure 3-3

The FMW program group, as shown in Figure 3-1, contains the FMW application, the Heater
Control for Windows (HCW) application, the Dispense Out debugging gpplication, a DOS
Prompt icon and a ReadMefile.

HCW controls the heaters and cooling devices on equipped systems.

Dispense.Out opens a text file where al debugging information is recorded. For
more information on this, contact Asymtek Technical Support.

The ReadMe file contains setup instructions for FMW after initial installation or an
upgrade. It adso provides alist of known bugs and workaround solutions for them.

The Cognex Vision Processor program group is used to operate the Cognex Vision

System.

The Video Blaster program group, shown in Figure 3-2, and the Matrox program groups,
shown in Figure 3-3, are optional video mixers for the advanced vison system, AV-2550
Automatic Fiducial Locating System.

3-4
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FMW Windows and Menus Tour

Use the mouse or trackball to explore FMW while being guided on this tour of the menus.
There are five mgor windows in FMW:

Main Window
Programming Window
Run Window
Production Window
Tools Window

A secondary window called the Teach Window, which displays the camera image from the
vision system, is accessed from the Programming Window. Submenus and options arein
drop-down menus below main buttons in al windows.

Each section below visits al the main features of each window and explains the screen area,
toolbars, icons, buttons and drop-down menus.

To start FMW:

1. Inthe FMW program group, double-click on the FMW icon.

)

Frdwi2. 7

» FMW will now load. It will check to seethat al the Input and Output (1/0O)
devices for your dispensing system are communicating properly with FMW.

¥
u‘ Do not press any keys or the mouse while FMW is booting.

@ If you get any errors regarding the Conveyor, Dispenser, Heaters or Vision
System, refer back to Chapter 1 - Getting Started and check the readiness
of your dispensing system.

,@5 NOTE If you are attempting to go through this tour not connected to a
dispensing system, or if components of your dispensing system are
missing, you will need to modify the FMW Configuration file or the
system may not boot. Contact Asymtek Technical Support for
assistance.
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» Thefirst window shown is the Main Window described bel ow.

Main Window

The Main Window buttons, Run a Program, Teach a Program, and Tools give access to those windows.
Configuration activates the drop-down Configuration menu and cascading dialog boxes. SECS/GEM
opens the SECS/GEM Setup Window if your FMW includes the SECS/GEM Interface
option. Help accesses the On-line Help. Off-line Programming is a feature to be implemented in a

future release.

FMW is designed for use on adedicated PC. Using any other application while FMW is
running may interfere with FMW normal operation.

/lsym

Accesses the

Production
Window T
\_*é'f

Accesses the S p——

Programming
Window

Access Off-ine ———
Programming

BN
Exit FMW /i

Asymtek Fmw v2.6 - Main

Run a Program

Teach a Program

Off-line Programming

Exit

tek

A NORDSON COMPANY

Activates
Configuration
drop-down
Menu

SECS/GEM
Option

Accesses

Help

Version 2.6 Accesses

the Tools
Window

Fluidmove’

On-line

Figure 3-4

linch | [NURM

Help

Units Selected
from

Configuration
Menii
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Configuration Menu

= Click on Configuration in the Main Window to access the drop-down Configuration
menu shown in Figure 3-5.

This menu is used to configure program preferences, setup fluids, service stations, and
system components prior to starting a programming session. Needle Setup, Setup Conveyor and Setup
Dispenser have cascading menus as indicated by the [ 7]. All menu selections bring up other
dialog boxes when you select the configuration options.

Asymtek Fluidmove - Main

a A NORDSON COMPANY

+Use Inches : - Pl’Ogl’am

Use mm - Preferences
Use Machine Units

Run a Program Change Operation Level... e
Needle Setup » L i
Prompted Setup Opti Initialization

and Operator
Level Setup

Setup Runtime Preferences

Setup Fluid Manager...

Setup Valve 1

Setup Valve 2

Setup Height Sensor...

Setup Locations...

Off-line Programming E Setup Purge Station...
Setup Scale Location... Setup and

Setup Yision... . :
Setup Workpiece Alignment Conflguratlon
of System

Exit NS Setup Conveyor 1 . N

e Setup Conveyor 2 Fluidmove Components,
Setup Dispenser | FOR wiNDOWS" Workpieces
Setup Heater Configuration... Version 2.6 and Fluids
Setup Event Logging...

Setup Password... \ linch | THLIK

b

Teach a Program

]

v v

Optional Settings

Figure 3-5

=» Asan example, select Setup Vision from the Configuration menu.
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The Setup Parameters dialog box shown in Figure 3-6 opens. This didog box alows you to
identify and calibrate the Vision System, and set specific preferences for fiducial searches.

Yision Parameters | x|

coonex 8
wathox 2

Figure 3-6

=» Choose Cancel to exit the Setup Parameters dialog box.
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Tools Window
» |Inthe Main Window, click on Tools.

The Tools Window shown in Figure 3-7 has buttons that allow direct communication with the
major components of the dispensing system, the Dispenser, the Conveyor, the Scale and the
Heaters.

Figure 3-7

= Click on Terminal to display the drop-down buttons shown in Figure 3-8.
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Figure 3-8

Clicking on Dispenser, Conveyor or Scale will bring up a Terminal Mode window. In the Terminal
Mode Window, you can type commands for the device. The Dispenser and Conveyor use
Automove Control Language (ACL) commands and the Scale uses its own command
language. For information on ACL or Scale commands, contact Asymtek Application
Engineering. Heater accesses Heater Control for Windows.

= Click on Conveyor to see an example of the Terminal Mode window.

» Click on Exit to close the Terminal Mode Window and return to the Tools
Window.

® Click onl/0 Test in the Tools Window.
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Figure 3-9

Dispenser and Conveyor, shown in Figure 3-9, are used to access the I/O Test dialog box.
» Click on Dispenser to see the I/O Test dialog box.
» Choose Cancel and return to the Tools Window.
= Click on Main to return to the Main Window.
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Programming Window

The Programming Window is where al programming is performed. It has alarge menu
structure and many icons to smplify keystrokes.

Men
BaL: \

=» To view the Programming Window, click on Teach a Program.

Asymtek Fmw v2.6 - Programming Window

File Edit Program Setup Bun Yiew Help

| 00 i
e EIEIREEIE dln | 2[w)[0mo] T [ [2][3]
Process / Program: ALTHEA.FMW  Fluid1: ¥1.FLU Fluid2: ¥2.FLU Pattern Name: |y\forkpiece |1
Toolbar
El EnD: —
~Om
Program Name Pattern Name Dispensing Elements
Text Box Text Box &
Comments | Send ACL
(Y=
Fattern Process
Dispensing Program = '\tx
Program Commands Matinn
Command Toolbar ==
Incartinn Dnint Eoﬁeﬁr
Units Selected in
Configuration
Nnch UM
Figure 3-10

There are two toolbars in the Programming Window. The icons and commands are identified
below. The largest screen area of the Programming Window is for the dispensing program
commands. New program commands are inserted above the insertion point.

3-12
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Process Toolbar

The commands associated with each icon in the Process Toolbar are identified below.
However, you will notice that FMW toolbars have Tool Tips. Asyou scroll the cursor over a
button, a“tip” appears below the button, explaining the function. If a button appears greyed-
out, that means that the command is not available at this point in the programming session.
The Wet/Dry Mode and Camera On/Off buttons are toggled to change between the two

modes.

Run a Program

Pause Run after
Next Command

Return to Main Window

. Stop Run atend
Paste P L
aste Frogram Lines of Current Board
Access On-Line
Help
Copy Program Lines Run Program
in Steps
Measure Flow
Rate Command
Cut Program Lines Abort Run
al k. g i
< S| (el [n]nld]e][F][6)|mk] I 3] 2]
Purge Valve
Print Current Load a Board
Program
Display Video
Save Current Unload a Board
Program
Wet or Dry Move Dispenser
Open a Program Run Mode to Home Position
File
Create a New
Program File
Figure 3-11
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Program Commands Toolbar

The commands associated with each icon in the Program Commands Toolbar are identified
below.

Opens Teach Window

for Programming

Dispensing Instructions
i

+
+*

NN =

Dizpenzing Elementz Insert an A(_:L
Insert a Comment Command into
into the Program \ Eﬁf @/V the Program

A

Comments | Send ACL

Create a Pattern ————— | [«= g | — InsertaProcess
Command into

Fatt P
'atterh rocess the Program

LUR

Create a i
Procedure Frocedure | Mation \ Insert a Motion
Control
= Command into
Insert a Timer | _Time_[Conweyor the Program

Command into

the Program
For Systems

Equipped with
Dual Conveyors

Figure 3-12

=» To view an example of what you see when you click on one of the icons, click
on the Motion icon.
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Dispensing Element Toolbar

An additional toolbar is available in the Teach Window. It is shown bel ow.

=» Toview this Toolbar, click on Dispensing Elements to open the Teach Window.

Types of Dispensing
Patterns Available

» -
Dk Litue
A Circle

Area and
Spiral FllIs

Rectangle | Potting

=2 | ©

Areafill | Spiral Fil

Opens Weight-Control

Lines Teach Window —

@ [

b bl lines |k ctlFll

/

Process Command

Command for
ot / Placing a Pattern

Fird sub He| Pattert

to Find Substrate
Height

i @

Zelect val | Multipass

Used for Setting
Up a Multipass

Pattern

Option for Dual
Action Dispense

Figure 3-13
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Programming Window Menu Bar

The menu commands on the menu bar activate drop-down menus. Some drop-down menu
selections go to dialog boxes. Menu sdlections and an explanation of the basic category of
command are shown below.

» Use the mouse or trackball and select one of the menu commands to see the
drop-down menu.

File

Edit

Program Setup Bun Yiew Help

[ N

New Ctrl+N Cut Ctrl+X
Opgn Cl:lpy Ctrl+C LII'IE
Save Paste Ctrl+¥ Em
Save As... Edit Main Program Circle
. Edit Procedure Rectangle
Fluid Table Edit Pattern o J
Recipe Delete_Pmcedure!Pattern Pot
- — Area Fill ’
Print... Ctrl+P Edit Fiducial Info Weight Control Line
Print Preview Edit Pattern Skip Info... Comment
Print Setup... Realign Workpiece —
— Height Sense »
Beturn to Main Show Advanced Dot Param...
— Edit Dot Parameters Pattern ’
Recent File Edit Line Parameters Process Commands 4
Time Commands 4
Edit Program Options 13 Motion b
Conveyor 4
Library »
Set ZFast Mode
) ) Dispensing Dispensing and
Dispensing Program Editing Process
Prog_ram F_lle Commands for Commands to
Manipulation Editing Existing insert into
Conmmande . . .
Program Lines Dispensing
Programs
Figure 3-14
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File Edit

Program Setup Bun VYiew Help

Dry Bun
Wet Run

Pass Through Run

Log File

Bun Output File

+ Toolbar
v Status Bar

Yideo

Stop

Pause
Single Step
Abort

Manual Board Load
Manual Board Unload

Dry Mode
Run To File

Prompted Setup

Valve Ofisets

Find Needle XYZ2
Measure Flow Rate
Purge Needle

Purge Needle Infinite
Vacuum On

Vacuum Off

Move To Front

Demo Mode Wet

Valve »
Heater

Manual Board Load

Manual Board Unload
Download Conveyor Atom  »

Setup Commands
for the Dispensing
System and Control

nf CAamnnanante

Run Commands
for Doing a

Sample Run of a
Pranram

Figure 3-15

Using Help

About Fluidmowe...

Access to On-line
Help and
Program

InfAarmatinn

Commands for
Viewing the Log
File Displaying

Prafarenrec
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= Click Dispensing Elements on the Program Commands Toolbar to open a Teach
Window.

Teach Window

The Teach Window includes a message area with instructions for the user, a camera video
display of the dispensing area, teach command buttons for teaching locations, X-Y-Z Position
Controls for moving the dispensing head, and a dialog box section that changes depending on
the selected dispensing command. The appearance of the Teach Window varies depending
on the task you are performing. For example, the Teach Window that opens for programming
a Weight-Control Line is different from the Teach Window for programming an AreaFill.
The options available will be specific to the dispensing eement type.

The Position Controls (shown in Figure 3-16) in the Teach Window are identical to the
Position Controls on the front Dispenser Control Panel. To move the dispensing head
forward, backward, left or right, click on one of the arrows. To move the dispensing head up
or down, click on the Z-Axis control box next to the down arrow, then either the up or down
arrow. Tomove rapidly in X, Y or Z, click on the center bolt and then the arrow buttons.

Each click on the Position Control arrows for up, down, left or right moves the dispensing
head 1 mil, which is barely perceptible to the naked eye. Clicking on the bolt and then an
arrow moves the head by 50 mils.

The Target Box isamodel of the entire dispensing area. It has a crosshair that represents the
current location of the dispensing head. Y ou can move the dispensing head by moving the
crosshairs.

Also, FMW has “Point and Click” position control which allows you to point to a position on
the video overlay, click the mouse button and the camera will move to that point in one
motion, centering the crosshairs on the point.

The Teach Window for programming aline is shown in Figure 3-17. Notice the Instruction
Message Box. Instructions appear in this area to guide you during the teaching process.

[ |

Figure 3-16
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Instructions to
the User

Teach Command
Buttons

Asymtek Fmw - Teach Window
I : I
Teach start point... P
L ]
Dt Line
Teach
_ 0|0 : .
Are | Circle Dispensing
Ll O @ Elements
= / Toolbar
VldeO Done Rectangle [ Potting
Display =|©
C Areafill | Spiral fill
Cancel
Poszition: @ @
it ctl fines |k et Fll
X 11.385 -
Y 10.264
Z 0.000 Find sub Ht| Pattern
-Brightness: U u
E 10 Selet val | Mhltipass
[a]
Start Point: |0.000 [0.000 Go loI | < > |
Dialog Box EndPoint  [0.000 | [0.000 Go to] Tl X-Y-Z
Area Varies : — Position
with Line Style:  [type 1 ERE Controls
Commands
More...

_

Target Box for “click and
move” Position Control

Figure 3-17

Y ou can use the X-Y-Z Position Controls in the Teach Window, as shown in Figure 3-17,
using amouse or trackball, or you can use the Position Controls on the Dispenser Control
Pandl to move the dispensing head around the dispensing area.

=» To get used to using the Position Controlsin FMW, click on the D and then

],

A The dispensing head will move approximately 50 mils.
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=» Now, click on alocation in the Target Box. The crosshairs and the dispensing
head move to the new location.

A The dispensing head will move to the new location.

» To exit the Teach Window, click Cancel.

=» To exit the Programming Window and return to the Main Window, click on
the menu bar.

=» Inthe Main Window, click on Run a Program.

Production Window

The Production Window is primarily used by production operators during daily production
runs. It is also used by process engineers while testing a new program. Load, Setup, Run and
Shutdown have drop-down buttons and menus.

Name of the Last Returns to the
Loaded Program Main Window

Asymtek Fluidmove - Production Window

Current Program: Aoxomoxoa

u 0o E 3
" off @ ok q«» Main
b Gy, - -9
Load Setup Run Shut down Help Jog Main

Figure 3-18

» To seethe Load diaog box, click on Load. The File Open diadog box opens.
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Fluidmove
Files are
FileName.fmw

Aszymtek Fluidmove - Production Window

Curient Program: Aoxomoxoa

~
= L Main 3
Load Main
File Name: Directories:
I—m c:\imwiprogram
C. |
dbcursi_fmw - e - LI
filename._fmw
1an_rem1_fmw 3 fmw Help
kamranl_fmw {4 program
multipas. fmw —I
underfil_fmw Hotworks
wesalec fmw ¥
-
List Files of Type: Diives:
|FMw Files [~ fmw) =l | =T =l
¥ Attach Fluid File
¥ Attach Heater File
|For Help, press F1 linch | [
Figure 3-19

When you write a program in FMW, thefileisstored asa<f i | ename>. f nw file on the

hard drive of the computer or to a specified network drive. The last file saved is automaticaly
loaded upon FMW startup. Alternatively, anew file is selected from the list as shown in
Figure 3-19.

Fluid files, used to define the dispensing fluid characteristics, are attached to the program you
choose to run. Also, Hester files, which set your heaters, are attached to your file at this

didog box.
»

Choose Cancel to close the dialog box.

» Click on Setup to see the drop-down menu Setup options.

Tour of Fluidmove
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Aspmtek Fluidmove - Production Window

Current Program: Aoxomoxoa

d

i} 1
off ' on

= &:l 4 » Main
Load Setup Run Shut down Help Jdog Main

Prompted Setup

Measure Flow Rale
Move to Front

Purge Needle

Purge Needle Infinite
Setup Heater
Vacuum On
Vacuum Off

Valve Offsets

Setup Routine with on-screen
prompts for each item that
needs to be setup prior to a

nradiirtinn riin

Options for setting up individual
items prior to a run. Options
vary depending on Operator
Level.

|FarHelp, prass F

linch | |

Figure 3-20

Most of the time the operator will choose Prompted Setup to run a program. On-screen
prompts cue the user for setup steps such as changing the needle or syringe. Customized,
scripted Prompted Setup routines can aso be created. Thiswill be demonstrated in a tutorial

later in this manudl.

= Click on Run to see the drop-down menu.
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Asymtek Fluidmove - Production Window

Starts the Run
and Goes to the
Run Window

Single Wet Run
Controlled Run
Commands

Figure 3-21

» Click on Run Production to access the Run Window.
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Run Window

Thiswindow contains system controls for starting, stopping or pausing the run and access to
the SECS/GEM interface control. All fluid information entered from the Setup Fuid didog
box from the Configuration menu is shown in this window aong with real-time fluid Satistics
such as arunning timer of the pot life and thaw time since the beginning of the run. The Run
Window shows the run statistics such as number of boards, run-time and failure counts. Also
awarning box at the bottom of the screen aerts the operator to system conditions.

The screen shown in Figure 3-22 is what the operator sees during production runs. If
you have a SECS/GEM Interface Option, you will see the see SECS/GEM tab.

Fluid Information
and Statistics

Asymtek Fluidmove - Run Window

Run Status | Wision |

‘Run Info: rFluid Info:
Program: untitled Fluid Name: Generic Fluid g
SECS/GEM
Run Count: 0 Lot Number: <none>
Date Started: 1998-09-03 Thaw Date: 2001-01-01
Time Started: 12:42:43 Thaw Time: 01:01:01
Cycle Time: 0000 sec/board Remaining Pot Life: 21311:23:28 Go ’
Failure Count: 0 Low Fluid Status: DISABLED
Flow Rate: 12.00 mg/s
-Run Setup: 9/ F'ausell
@ Wet O Dry Next Purge: DISABLED
Next Flow Rate Calib: DISABLED Stop .
[T Use Conveyor
X Set Number of Runs: |1
14:32:46 --» Stopped X
| :

|
o

Messages to Operator
about System Status

linc I/ [NUM
7

Run Control Commands for
the Dispensing System

Figure 3-22
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SECS/GEM Interface

If you have the SECS/GEM Interface Option, refer to Chapter 5 — SECS/GEM Interface to
tour the windows of the SECS/GEM Interface. For SECS/GEM Interface programming
information, refer to the SECS/GEM Interface Option Reference Manual.
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4 Heater Control for Windows

Heater Control for Windows (HCW) is an accessory application that allows the user to
directly control dispensing system heaters, needle heaters, fluid cooling and temperature
sensing devices.

This chapter explores the user interface of HCW and teaches you how to set up the
configurable options. Most settings are set at the Asymtek factory at the time of shipment
and usudly do not need to be changed.

For detailed explanations, factory-set configuration settings and advanced controller
optimization information, refer to the Anafaze User’ s Guide which should be included in your
dispensing system documentation. The Anafaze is the controller used in the dispensing
system that communicates with HCW. While you will only be able to access the controller
through HCW, the reference manual till contains valuable information on settings.

To tour Heater Control for Windows:

1. Inthe FMW Main Window, click on Tools.
2. Inthe Tools Window, click on Terminal.

3. Click on Heater.

When Heater Control for Windows (HCW) opens, the first window you seeis the Loop
Parameters Window which displays each available controller loop and the settings for each
loop. Not every available controller loop will be connected to a functioning heater element.
The loop names are set at the Asymtek factory, but can be changed to fit your specific
requirements. Optional fluid cooling, needle heater and temperature sensing devices may also
be identified as aloop, dong with the heaters.
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Thiswindow is used as a quick-check for viewing Set Points and Present Vaue. Later in this
chapter, you will learn how to set these options.

This dialog box shows These lists show the These buttons are
the model number of the Mode, Set Point (SP) used to upload and
controller and the temperature, download heater files,
vercinn nf tha firmwara Present Value (PV), save current settings
Units and status of and start the Alarm

each available loop. Acknowledgements.

Heater Control for Windows

Controller Info:
Model: CLS EPROM Version: 2.30 Current Heater|File: |C:AFMWAHEATERA\MELTDOWMN_HT
Channel Parameters:

On/Off Channel Name Mode SP PV Uit Message Dozl
223221 01: Loop name... Manual |[60 24 | Lo Dey
125424]02: Loop name... Manual || 90 24 ‘C (1] 4
|25422|03: Loop name. . Manual || 90 27 ‘C (1].4 Upload
|22222(04: Loop name... Manual [[55 23 ‘C Lo Proc
|22222(05: Loop name... Manual [[120 25 ‘C oK
139242(06: Loop name... Manual [[120 26 ‘C oK
129242(07: Loop name... Manual |55 24 ‘C Lo Proc Save
129242(08: Loop name... Manual [[120 24 ‘C oK
1254221 09: Loop name... Manual || 80 24 ‘C (1] 4
125422 10: Loop name... Manual ||50 760 ‘C (1].4 1
122222(11;: Loop name... Manual ({30 20 ‘C (1].4 Preferences
122222(12: Loop name... Manual [[90 22 ‘C oK IR—

13: Loop name__. Manual |90 22 T oK

14: Loop name... Manual |25 1400 *F 1] 4

15: Loop name... Manual |25 1400 *F 1] 4 Help

16: Loop name... Manual |25 1400 *F 1] 4

17: Lgop name... Manual || 200 1] HZ 1] 4

About
Idle.
FMW

These areas display the
name of each loop and
its On/Off status. Yellow

ic NNl Aravie NEE

Figure 4-1

Next, use the mouse or trackball to highlight any loop and double-click on the loop name.
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Each loop has a dialog box which shows its settings under the Main tab.

Figure 4-2 shows the Main tab dialog box and the tabs to access more dialog boxes. In
the Main dialog box, you set the temperature with Set Point. The Output Vaue isthe
percentage of the heater’ s total capacity that is being used to achieve or maintain the
Set Point. Auto Mode regulates the loop temperature automatically. Manual Mode
disables the automatic temperature controller and alows you to regulate loop
temperature using the Output Value.

g NOTE Operating in Manua Mode is not recommended. Output Vaue can not

exceed Heat Output Limit. See the Output tab.

Tabs for Accessing
Other Windows.

Heater Control Window - Loop Parameters

Main | Run Time | Heat Contral | | mpLt | Cutput | Ailarm

The Selected
Loop Number :

__leop HName 01: Loop name.._.

and Name— | |

Appears in this

Dialog Box.

Mode

® Auto () Manual Output Yalue (% Heat]: |0.

Temperature and Settings

Turn-on Settings. Set Point [SP): |60 Unitss CF @&

114 | | Cancel | | Apply | | Help

Figure 4-2

From the Main tab, select the Run Time tab.
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= Heater Control Window - Loop Parameters

Figure 4-3

The Run Time dialog box shown in Figure 4-3 shows the parameters for configuring heater
behavior during production runs. The heaters can be turned off or turned down during fiducial
searches. Heater temperature can also be verified before dispensing begins.

From the Run Time tab, sdect the Heat Control tab.
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= Heater Control Window - Loop Parameters

Figure 4-4

The Heat Control diaog box shown in Figure 4-4 shows control parameters that are used to
define the heating process for your specific system. All values in this dialog box should be set

at the Asymtek factory prior to shipping and should not be changed by the user. For more
information, consult the Anafaze User’s Guide.

Next, select the Input tab.
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= Heater Control Window - Loop Parameters
I airy | Fiun Time | Heat Control Input | Output | Alarrm |
Type: |J Thermocouple Iil
Input Reading Offzet: |0 Degrees
Input Filter: 1] Scans
1] | | Cancel | | Applp | | Help
Figure 4-5

The Input didog box in Figure 4-5 is used to define the input types for each loop. Unused
loops which do not have heaters attached are defined as “ skipped”. Also, any process offsets
to make up for signal inaccuracy are set here. All settings in this dialog box are set for each
loop in your system at the Asymtek factory prior to shipping.

Input Reading Offset can be used to make up for a calibration offset. The thermocouple
inside of the heating element may register avalue that is different than the temperature of the
part. Also, for temperatures below 400° F (204° C) a thermocouple may be inaccurate by
several degrees. To adjust for this offset, use an independent thermocouple and determine the
true temperature of the part you are heating. The difference between the true temperature
and the PV isthe offset. To add thisinformation to this menu, change the Input Reading
Offset. A positive number increases the reading. Input Filter is usually used to compensate
for noisy signals. However, the dispensing systems are shielded to avoid noise.

/}?\ Only trained engineering personnel should attempt to make offset
measurements or change any settings in this dialog box.

Select the Output tab.
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= Heater Control for Windows - Loop Parameters

I ain | Fiun Time | Heat Contral | Imput Output | Alarm |
[ Enable
Type: |Time Proportioning [TP] |i|

Action: . Direct @ Heverse

Heat Output Cycle Time: |1 Seconds [TP only]
Heat Output Limit: 100 X
Heat Output Limit Time: |0 Seconds [0=continuousz]
(1] 4 | | Cancel | | Apply | | Help
Figure 4-6

Figure 4-6 shows the Output dialog box which is used to define the type of output the
controller uses for the heating process and specific parameters for the output type. All
settingsin this dialog box are set for each loop in your system at the Asymtek factory prior to

shipping.

The Type of output mostly used for the dispensing system heaters is Time Proportioning
(TP). In this Type, the percent output is converted to a percent duty cycle on the
programmed cycle time. The Action sets the control action of the loop. Normally, heat
outputs are set to Reverse and cool outputs are set to Direct.

Heat Output Limit can be used with IR heaters to limit the temperature ramp. Thisis done to
prevent damaging heated components on the workpiece by ramping the temperature too fast.

Lastly, select the Alarm tab.
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tdain | Fun Time | Heat Control |

High Process Alarm:

Output Humber: |0
’7

Set Point: 70
(' O @ Alarm [ Control

High Deviation Alarm:

Output Number: |0

' D @ Alarm [ Control

= Heater Control Window - Loop Parameters

Input | Output Alarm |

Low Process Alarm:
DOutput Number: |0
50

(C/ OfF % Alarm (' Control

Set Point:

Low Deviation Alarm:

Output Number: (0

(") O ® Alarm (' Control

Delay: (0O Sec Deadband: |0 Dewviation: |5
| 114 I | Cancel | | Apply | | Help |
Figure 4-7

The Alarm diadog box shown in Figure 4-7 is used to setup the process alarms. The alarms
can be set for each loop. The alarms identify and notify the user of changes and deviations
from the temperature Set Point.

Process alarms can be set to notify the operator and/or control the output in the event of
deviations from the Set Point. Figure 4-8 shows the activation and deactivation points. There
are four alarm types: High Process, Low Process, High Deviation and Low Deviation. These
points are shown in Figure 4-7.

For each type of arm, you assign an Output number, then select how the alarm should be
handled, or choose Off, for no darm. If Alarm is chosen, you will get an darm notice. In
FMW, this notice is not readily visible, so it is recommended that you select Contral. If you
select the Control setting, the output of the loop will be adjusted to the Set Point if the darm is
activated. Setting this Set Point to zero ensures that the heater will shut off in cases of over-
heating. Thisis the recommended setting.

For Low/High Deviation aarms, set the number of deviations that you will allow the Set Point
to exceed before the dlarm is activated and the output controlled.

To return to the Heater Loop window, click on the window control button in the upper
left corner of the window (Win 3.x) and choose Close.

To exit Heater Control, click on the Exit button.
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Figure 4-8
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5 SECS/GEM Interface

FMW can be configured to interface with a GEM system. This is a factory-set option. Y our

verson of FMW might not have a SECS/GEM interface option. If it does not, your
SECS/GEM interface button on the Main Screen will be grayed and disabled.

Below is adescription and tour of the user interface for the SECS/GEM option. It is intended
as an Operator Guide. Detailed interface programming information and terminology are
contained in the SECS-GEM Interface Option for Fluidmove for Windows Reference
Manud.

To explore the SECS/GEM interface:

1. Inthe FMW Main Window, click on SECS/GEM.

» The SECS/GEM Setup Window opens to the Control tab. See Figure 5-1. In
the Control tab, the Programmer can use the Control buttons to toggle the
Control State. Otherwise, the system uses the default settings on the Setup
tab.

»  Also, the Programmer can click on the Communication buttons to toggle the
Communication State. Otherwise, the system uses the default settings on the
Setup tab.

» To get date and time synchronization from the hogt, click on Get Date & Time.

— SECSIGEM Setup
Control | Terminal | Setup | Camrunication |
Control: | On-Line Local On-Line Remote Off-Line ‘
Communication: Enable ‘ ‘ Disable ‘
Spooling: Enable ‘ ‘ Disable ‘
‘ Get Date & Time ‘
Communication State: |ENABLED!CDMMUNICATINE
Control State: |ONLINE/LOCAL
Spooling State: |ENABLED!INACTIVE
1] & | | Cancel | | Apply | | Help
Figure 5 -1

SECS/GEM Interface 5-1



2.

3.

Click on the Terminal tab and refer to Figure 5-2.

>

Control Terminal | Sehup | Communication |

= SECS{GEM Setup

Incoming Meszage: +
Acknowledge I
[+]
Outgoing Meszage: +
:
[+]
Communication State: |ENABLED!EDMMUNIU\TINE
Control State: |ONLINE/LOCAL
Spooling State: |ENABLED/INACTIVE
OK | | Cancel | | Apply | | Help
Figure 5 -2

Click on the Setup Tab and refer to Figure 5-3.

>

= SECSIGEM Setup

Cantrol | Terminal Setup | Commuhicatian |
Establish Communication Timeout: |5 Second(s]
Default Communication State: | ENMABLED
Default Control State: | OMLINE/LDCAL

If On-Line Attempt Fails Go To: |I]FFLINEJ'HI]ST OFFLINE

X Beep until incoming message acknowledged

[ie] [re ] [re]

Communication State: | ENABLED/COMMUNICATING

Control State: ||]NL|NEJ'LI][:AL
Spooling State: |ENABLEDJ‘INAETIVE
oK | | Cancel | | Apply | | Help
Figure 5 -3

Thistab is used to acknowledge and send messages to and from the host.

Thistab is used to setup the default Communication State, Control State,
message and communication handling.
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4. Click onthe Communication Tab and refer to Figure 5-4.

4

)

Control | Temninal | Setup | Communication |

Host IP Address: |I]_I]_I]_I]

Device IP Address: ||]_|]_|]_|]

Device ID: Dx7FFF

Thistab is used to establish addresses for the host and the device.

= SECS/GEM Setup

Communication State: | EMABLED/COMMUNICATING

Control State: ||]NLINEJ'LI][:AL
Spooling State: |[ENABLED/INACTIVE
OK | | Cancel | | Apply | | Help
Figure 5 -4

5. Click on Cancel to return to the Main Window.

6. Inthe FMW Main Window, click on Run a Program.

7. Inthe Production Window, click on Run.

8. Click on Run Production to go the Run Window.

9. Click onthe SECS/GEM Tab and refer to Figure 5-5.

>

Changes in this dialog box require exiting and restarting FMW in order for the
changes to take effect.

This is the message area that the Operator has access to during a production
run. Messages are acknowledged and received.

SECS/GEM Interface
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Asymtek Fmw v2.6 - Run Window

ENABLED{COMMUNICATING

ONLINE/LOCAL

DISABLED

Figure 5 -5

10. Click on Return to return to the Production Window.

11. Click on Main to return to the Main Window.

This concludes the tour of the SECSGEM interface user interface.
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6 Setup and Configuration

This chapter guides you through basic configuration and setup routines. There are six types of
configuration and setup routines in FMW: System Configuration, Preferences, Initia Setup,
Programming Setup, Prompted Setup and Manual Setup.

System Configuration is done outside of FMW using FMWTools, a utility software included in
the FMW software kit. Preferences can be changed at any time within FMW. Initia Setup
should be performed on initidization of the system and after major hardware or software
changes. Programming Setup is a recommended routine to be performed prior to beginning a
programming session. Prompted Setup is a screen-prompted routine used prior to a
production run. Manua Setup is a group of options that allow the user to configure individua
components of the system.

When you purchase your dispensing system or upgrade to FMW, a service representative
from Asymtek will assist you in configuring the system with the software. After installation,
you will rarely need to change most configuration options unless mgjor hardware changes are
made to your system. These options include Setup Height Sensor, Setup Conveyor, Setup
Dispenser, Setup Locations, Setup Purge Station and Setup Scale Location.

Go through each Setup Routine exercise in this chapter. Y ou will be asked to repeat some of
these procedures in later programming exercises.

Estimated time to complete: 45 minutes.

System Configuration

After ingtaling your dispensing system, or after ingtalling or upgrading the dispensing
software, it is necessary to identify certain options included on the system platform. These
optionsinclude, but are not limited to, the following:

Com Ports

Valve type

Needle finder
Conveyor type

g NOTE Generdly, System Configuration is performed at the Asymtek factory prior

to shipping, and you may not have to perform this procedure. Contact
Asymtek Technical Support for more information.
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To configure the dispensing system:

1. Closedl open programs, including FMW.

In the FMW program group, locate the FMWTools icon  Fmutoos,
3. Open FMWTooals by double clicking on the icon.

» FMWTools has three levels of operation, Service Mode, Diagnostic Mode, and
Production Mode. To fully configure the dispensing system, you must have
access to the Service Mode. Contact Asymtek Technical Support for more
information.

4. Inthe FMWTools Man Window, click on Configuration Wizard.
5. Inthe Configuration Window, click on System Configuration.
» A secondary Configuration Window, shown in Figure 6-1, opens.

FM¥Y Configuration Wizard

Brome T8 | Cutonies Conia o |

e &
E
o &
T
O
ove et w0 |8
e 2
A
R

I
e &
e &

Figure 6-1

6. Click on the arrow next to each text box to view al available options and select the
appropriate option.
» Contact Asymtek Technical Support for help, if necessary.

7. Click on Apply to activate the changes.

This concludes the tutorial on System Configuration.
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Preferences

User Preferences for FMW are located on the Configuration menu in the FMW Main
Window. The list below identifies the customizable preferences available. Y ou may change
these preferences at any time.

Use (inches, mm or machine units) All measurementsin FMW will be
displayed in your choice of units.

Change Operator Level FMW limits access to menus by
use of this option. This option
works in conjunction with Setup

Password.

Setup Event Logging FMW gives you the option of
logging the process events that you
choose here.

Setup Password Use this diadog box to set user

access level passwords.

Units

Choosing a Unit determines how measurements will be displayed in FMW. The available
units are inches, millimeters or machine units. Machine units can vary dightly from one
machine to another but are defined as a single step, or the smallest increment that the X, Y or
Z motor can move.

To set Units;

1 Inthe FMW Main Window, click on Configuration to access the drop-down menu.

2. Movethe cursor to one of the Use (units) options and click onit.

» A check mark (v') appears next to the selected Unit.

Passwords and Operator Level

The highest operator level is Service, which alows full access to all menus and
windows and all available festures.

The second level is System, which alows full access to all menus and windows, but
restricts access to certain available features.

The third level is Production, which does not require a password and limits access to
the Production Window, the Run Window, and production level setup procedures
only.
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Default passwords for each level are shown in Table 6-1 below.

To setup passwords:

1
2
3.

In the FMW Main Window, click on Configuration.
Select Setup Password from the Configuration menu.

Enable the Service option, and type in an old password (if previoudy password
protected) and type in a new password in the appropriate text boxes.

@TIP Passwords must be selected for the service and System levels of
operation. Passwords can be up to 8 characters long. The default
passwords are shown in the table below. If you need help restoring
the defaults, contact Asymtek Technical Support.

Click on 0K.

Table 6-1 Passwords and Operator Level

Level Default Password
Service Service
System System
Production No Password Needed

» To see how the Operation Level restricts access to the menus, change the

Operation Level as described below. Vist the menus and windows after changing.

To change Operator Level:

1
2.
3.

Select Change Operation Level from the Configuration menu.
Select the level of operation you wish to access.

Type in the password for the Operator Level.

»  Themenuswill be appropriately restricted.
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Event Logging

It isagood ideato enable Event Logging so that you can check how your programs have

executed. Event Logging is a useful tool for troubleshooting. An Event Log file is stored by
daeinc: \ f m | og\ <yyyymrdd>. | og. To read the current file, select View from the
Programming Window menu and then select Log File.

&S NoTE

To setup Event Logging

Select Setup Event Logging from the Configuration menu.

Y ou must remember to “clean out” the Event Log directory regularly,
otherwise it will fill up the hard disk. Use File Manager to remove old files.

Sdlect the Categories for which you wish to keep log files and Enable or Disable
the Event options for each listed system element. Y ou can enable or disable
individua elements by double-clicking directly on the element. Use the scroll bar to
see more Categories. Refer to Figure 6-2 for information on the dialog box options.

Event Manager
System
~Bategorny: | Events: Miscellaneous
All related
bt - Cormer Edge Info = events for
= Yizion @ the
Q Fid Err Desc selected
: : system
Miscellaneous Fid Found
Scroll Bar @ 1 Foun component
(;) Fid Not Found are listed
Run — here
Fhad
hd Enable All
[ Log Tane or Disable
Heater Enable All | Disable Al All the
= /l_ Log Date listed
Events
114 |/ Cancel Help |
Activate to log time /
and/or date of the event
Figure 6-2
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Initial Setup

Your system isinitialy configured and setup by an Asymtek representative. However, it may
be necessary or desirable to repeat some of the configuration routines to insure programming
accuracy.

,@5 NOTE Initid Setup is not equivaent to a complete system re-instalation

configuration and setup procedure. If your system requires re-installation,
please call Asymtek for assistance.

There are two optiond Initia Setup procedures:

Calculate Master Offsets
Valve Offsets

Both procedures perform all of the necessary setup functions. The main difference between
the two procedures is that Valve Offsets alows you to perform the entire process one step at
atime. Calculate Master Offsets walks through the entire process from start to finish.

,@ NOTE Even though both procedures perform al of the necessary setup functions,

they are not identical. It is recommended that you use Vave Offsets as
your setup procedure.

,@ NOTE If you change from one setup procedure to the other, it is recommended

that you exit FMW and restart FMW before performing the newly selected
procedure.

,@ NOTE Before performing either the Calculate Master Offsets or the Valve
Offsets setup procedure, you must first setup the Vision System.
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Vision System Setup

If the Vision System has not been calibrated snce FMW was initialy installed, you will
receive a notice when FMW starts, indicating that the Vision System has not been calibrated.

If the camera or any part of the vision system has been changed or upgraded, the Vision
System will need to be re-cdlibrated. It is also a good troubleshooting routine to perform if
you are having trouble identifying fiducials, corners or see an accuracy problem.

To start Camera Calibration:
1 Inthe FMW Main Window, click on Configuration.

2. From the Configuration menu, select Setup Vision.

» TheVison Parameters dialog box in Figure 6-3 opens and displays the
parameters configured for your system at installation.

Vision Parameters

General

Vizion System: COGHEX : Calibrate.
Video Mixer: MATROX :

[ Disable light and zound alarms Setup Reticles___

[ Use Anti-backlash Move

| II

Settling Time: 450 [msec])
@ C C
Fiducial Options Skip Mark Dptions
[ Pause After Search [ Pause After Search

If Fid Mot Found: @ Skip (' Prompt

Tolerances

Fiducial Location Tolerance: 100. mach
Diagonal Distance Tolerance: |100. mach

Orthogonality Tolerance: LN [deg]

| 1] 4 ‘ ‘ Cancel ‘ Help ‘

Figure 6-3

3. Click on Calibrate in the General segment of the dialog box.
» A Teach Window opens.
» Load aboard if oneis not aready loaded.

4, Usethe Position Controls to locate a Modd Fiducial.
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Click on Next.

» FMW checksthe fiducial location by offsetting the camerain al four directions
along the X and Y axis, and relocating the fiducial. This ensures that the
number of pixels moved within the video display window is properly calibrated
to the number of milsthe X and Y motors must move to find the same location
in the dispensing area.

» When this processis complete, an X,Y vaue is displayed in the Instructions
area a the top of the Teach Window. The X and Y vaues should be relatively
equal. If you notice a large difference between these two va ues, you should
perform the calibration procedure again and re-teach a new fiducial.

Click on Done to accept the results.
» The Teach Window closes and you return to the Vision Parameters dialog box.

Notice Setup Reticles in the General section of the Vision Parameters didog box.
» Reticlesare overlaid linesin the video display to help define fiducids.

Click on Setup Reticles to explore this option.
» A Teach Window, shown in Figure 6-4, opens.

» Aswadl asbeng helpful for defining fiducials, reticles can also be used during
programming to keep the needle close enough to the part for effective
dispensing, but far enough away to prevent part chipping. See “Chip Offset” in
Chapter 9 — Advanced Programming for more information.
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Asymtek Fmw v2.6 - Video Reticles Setup
Click [Done] if reticles acceptable. E E

Help
Done

LCancel

Position:

X 12.459
Y 10.987
Z 0.000

Lighting: —

X Circle 1 [diameter] [* Circle 2 [diameter) (" Black 12 J

-0200 inch 0.0500 inch i# White
0 Additional circles | h 4 |
[]

[X Rectangle [XY size]
|0.080 |0.050

]

K

inch

[X Crosshair graduations +

Figure 6-4

9. Click on Help for complete details on the reticles option.

10. Click on Done when complete.

This concludes the tutorial on Vision Setup.
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Height Sensor

The Height Sensor Configuration window alows the operator to establish parameters such as
speed and distance for raising and lowering the dispensing head. The window is divided into

two sections; Mode and Parameters.

Mode

If your dispensing system is equipped with a Height Sensor, you will have two options in this
dialogue box: Height sense always and Height sense on command.

Table 6-2

Height Sensor Modes

Mode

Description

Height Sense Always The Height Sensor probe is always down except during actual
dispensing. The dispense height is established during Setup.
This mode is useful if your board is warped, as it guarantees an
accurate dispense gap.

Height Sense on You can put a Find Substrate Height command into your program
Command to perform a height sense at a taught location on the workpiece.
A Height Sense Off command will be ignored in this mode.

If your dispensing system is not equipped with a Height Sensor, you must use FMW Tools to
tell it that no height sensor is present. Height Sensor must be set to None. Valvel Height
Sensor must be OFF. When your system has been configured for no Height Sensor, you will
be able to access the following Height Sensor configurations:

Table 6-3 Configuration Options — No Height Sensor

Mode

Description

No height sense — ask on every
workpiece

You will be asked to teach the dispense height at the
beginning of each workpiece by lowering the
dispensing head to the desired dispensing height.

No height sense — ask on first
workpiece only

This option is excellent for batch dispensing or a
production run on a conveyorized dispensing system.
You will be asked to teach the dispensing height at
the first workpiece only. This information will be used
for each subsequent workpiece.

No height sense — use last known
substrate height

You establish the substrate height during Setup. This
information is used for all dispensing. This mode is
only available if your are running in Calculate Master
Offsets mode, allowing the dispensing height to be
changed automatically after a needle change.

6-10
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Parameters

Down Speed

Up Speed

Acceleration

Max. Search
Distance
substrate

Retract
Distance

Height Sensor Setup

The rate in inches per second that the dispensing head descends to
the point where dispensing begins.

The rate in inches per second that the dispensing head will go up
after each dispense.

The rate at which the dispensing head goes from being stopped to
reaching either the designated Down Speed or Up Speed.

Establishes a maximum d stance that the dispensing head
descends from absolute zero when searching for the

surface. If the Height Sensor does not |ocate the substrate surface
within the Max. Search Dist. Parameter, an error box will appear
in the center of the screen. Adjust the distance accordingly.

The vertical distance the dispensing head moves upwards after

dispensing. The Retract Distance must be within the Safe
Z-Height. Retract Distance can be reduced to increase dispensing
Speed.

The Height Sensor Setup procedure varies depending on the Height Sense Mode. Perform
the Setup procedure that relates to your Height Sense Mode.

To perform Setup for Height sense always Mode:

1. Load aboard or part into the dispensing areg, if oneis not already present.

2 NoTE

Since you are teaching the Z-offset of the needle to the Height

Sensor, it is NOT necessary to use a board identical to one used
in production.

2. Make sure that the Height Sensor probe isin the up position.

» If the probeisnot in the up position, consult the Height Sensor section of the
Millennium Operations Manua for troubleshooting procedures.

Click on Next.

Make sure that the probe isin the down position.

» If the probeis not in the down position, consult the Height Sensor section in the
Millennium Operations Manua for troubleshooting procedures.

Click on Next.

Use the position control buttons to move the dispensing head to a dispensing
location on the workpiece.
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10.
11.

Lower the dispensing head until the needleis at the desired dispensing height.

» All subsequent dispensing operations will be performed at this height, including
dot and line parameter settings, except for ZFast dots.

Click on Next.
Follow the on-screen prompts for adjusting the probe height.
Click on Next.
Click on Done.

To perform Setup for No Height sense Mode (all three options):

1

Load a board or part into the dispensing area, if one is not already present.

g NOTE Since you are teaching the actua height of the dispensing

surface, you MUST use a board identica to one used in
production.

Use the position control buttons to lower the dispensing head so that it is just above
the substrate.

The location of the last height sense (if there was one) is displayed at the bottom of
the Teach window. If you choose to use the same measurement, click on GoTo, and
the dispensing head will move to that location.

Click on Teach.

» If you are running in Calculate Master Offsets mode, the dispensing head
performs a Find Needle XY Z procedure.

Click on Done to save the results.

6-12
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Calculate Master Offsets

This screen-prompted routine identifies and records a Safe-Z Height for dispensing head
travel, the XYZ locations of the Purge Station and Weigh Station, Needle and the substrate
height. It also calibrates the camera-to-needle and probe-to-needle of fsets.

Thisroutine is performed when the dispensing system is initidly installed and configured.
Those values and settings are recorded. Y ou can run this routine again at any time to insure
dispensing accuracy or reflect hardware changes. Y ou can choose to use pre-recorded
values during the routine.

Definitely perform a Calculate Master Offsetsif any of the following events occur:

initial system setup (re-installation of dispensing system)

re-initidization or re-ingalation of system software

software update

valve change (not syringe)

camera change or location adjustment

service gtation (Purge, Weigh Stations) change or location adjustment

Needle Sensor change or location adjustment

Height Sensor change or location adjustment

changing from Valve Offsets

&S NoTE

2 \ore

2 \ore

Calculate Master Offsets and Valve Offsets both perform all of the

necessary setup functions. The main difference between the two
procedures is that Valve Offsets allows you to perform the entire process
one step at atime. Calculate Master Offsets walks through the entire
process from start to finish.

Even though both procedures perform al of the necessary setup functions,

they are not identical. It is recommended that you use Valve Offsets as
your setup procedure.

If your dispensing system is equipped with a dua-action dispensing head,
DO NOT USE CALCULATE MASTER OFFSETS. For dual-action
dispensing heads, Valve Offsets is the recommended procedure.

Setup and Configuration
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To perform a Calculate Master Offsets procedure:
Follow al on-screen prompts.

1. Inthe Man Window, click on Configuration.
2. Click on Needle Setup, and select Setup Parameters.
» The Needle Setup Parameters dialog box opens. See Figure 6-5.

Needle Setup Parameters K

NS [7]

Figure 6-5

3. Select Calculate Master Offsets in the Machine Setup Process section of the dialog

box.

,@ NOTE If you are changing from Vave Offsets to Calculate Master
Offsets, it is recommended that you exit FMW and restart FMW
before continuing this procedure.

Click on 0K.

Click on Needle Setup on the Configuration menu again, and select Calculate Master

Offsets.
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10.
11.

13.

14.

15.
16.

17.
18.

19.

» A Teach Window opens asking you to clear the work area.

Make sure that the work areais clear and free of any obstacles so the dispensing
head does not collide with anything when it moves.

f{'\ The dispensing head will move after your response.

Click on Next.
» If you are not using a Height Sensor, skip to Step 9.

Check to make sure that the Height Sensor probe tip is lower than the needletip as
shown in the on-screen prompt.

» If itisnot, rotate the Height Sensor Micrometer until the probe is lower. Refer
to the Height Sensor section in the Operations Manual for your dispensing
system for more information.

If necessary, use atissue to clean any dripping fluid from the needle tip.
Click on Next.

Activate the Z-axis controls on the front panel Position Controls and raise or lower
the dispensing head to a Safe Z-axis height that assures that the head will not
encounter obstacles while traveling anywhere across the dispensing area.

Click on Teach to record the height.
Answer “YES’ to the question, “Would you like to re-teach the beam locations?’

» Choosing “YES’ meansthat you will re-teach the needle location in the XYZ
planes using the Needle Sensor.

»  Choosing “NO” means that the previously recorded vaues are used and this
step is skipped.

Use the Position Controls to move the needle tip very dowly into the entrance of
the Needle Sensor dot until the green LED on top of the sensor turns ON as shown
in the on-screen prompt.

» If the LED does not turn ON, lower the needle tip further into the dot.

» Refer to the Needle Sensor section of the Operations Manual for help locating
parts, if necessary.

Click on Teach.

Use the Position Controls to move the needle tip very dowly around the corner of
the Needle Sensor dot until the green LED turns ON again.

Click on Teach.

Use the Position Controls to move the dispensing head to the Weigh Station
location.

Activate the Z-axis controls and lower the dispensing head until the needle tip is
flush with the top of the Weigh Station lid.

Click on Teach.
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23.

24.

25.

26.

27.

28.

Use the Position Controls to move the dispensing head to the Purge Station
location.

Activate the Z-axis controls and lower the dispensing head until the needle tip is
flush with the Purge Station boot.

Click on Teach.

;’T\ The dispensing head will move after your response.
Do one of the following, depending on the type of Needle Sensor installed on your
system:

a. For NSZ Series Needle Sensor, use the Position Controls to align the Height
Sensor probe with the Load Cell on top of the Needle Sensor.

b. For NS Series Needle Sensor, use the Position Controls to align the Height
Sensor probe with the white dot on top of the Needle Sensor.

» If you are not sure what kind of Needle Sensor isinstalled on your system,
consult the Needle Sensor section of the system Operations Manual.

» If you are not using a Height Sensor, skip to Step 28.
Click on Teach.

f('\ The dispensing head will move after your response.

»  Thedispensing head automatically performs a height sense.

Use the Position Controls to aign the needle tip with either the Load Cell or the
same white dot on top of the Needle Sensor, depending on your type of Needle
Sensor.

» For NSZ Series Needle Sensor, DO NOT TOUCH THE LOAD CELL with
the needle tip. Center the needle tip over the Load Cell.

»  For NS Series Needle Sensor, TOUCH THE NEEDLE TIP TO THE
SUBSTRATE.

Click on Teach.

A The dispensing head will move after your response.

»  The dispensing head moves back to the Needle Sensor and automatically
locates the needle and the Height Sensor probe.

» If you get an error message that reads. “Probe to Needle Y offset (XX.XXX)
islarger than width of dots,” then adjust the Height Sensor probe so that it is
closer to the needle. Consult the Height Sensor section of the Operations
Manual for help, if necessary.

Place a sample substrate, or piece of paper with four dots in the shape of a square,
in the indented square on top of the Needle Sensor.

» |If you have aNSZ Series Needle Sensor, there should be a smulated
substrate aready present on top of the Needle Sensor.
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3

3L
32.

36.
37.
38.

Click on Next.

Select adot style in the box below the video display.

»  Consult the on-line help for assistance, if necessary.

Click on Next.

Answer “Yes’ if you are asked if you want to re-teach the reference dots.

Use the Position Controls to center the needle tip over the first smulation dot as
shown in the on-screen prompt.

Click on Teach.
Repeat the previous 2 steps for the other three dots.

»  Once you have taught the location of dl four dots, FMW automaticaly
dispenses the four dots, then asks for camera alignment for each dot.

Redlign the crosshairs to the dot, if necessary, or click on click on Teach.
Repeat for the other three dots.

Click on Done to accept the results.

This concludes the tutorial on Calculate Master Offsets.

Setup and Configuration
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Valve Offsets

This screen-prompted routine identifies and records a Safe-Z Height for dispensing head
travel, the XYZ locations of the Purge Station and Weigh Station, Needle and the substrate
height. It also calibrates the camera-to-needle and needle-to-probe offsets.
This routine is performed when the dispensing system is initialy installed and configured.
Those values and settings are recorded. Y ou can run this routine again at any time to insure
dispensing accuracy or reflect hardware or changes. Y ou can choose to use pre-recorded
values during the routine.
Definitely perform a Vave Offsats if any of the following events occur:

initial system setup (re-ingtalation of dispensing system)

re-initidization or re-ingtdlation of system software

software update

valve change (not syringe)

camera change or location adjustment

service station (Purge, Weigh Stations) change or location adjustment

Needle Sensor change or location adjustment

Height Sensor change or location adjustment

Changing from Calculate Master Offsets

g NOTE Calculate Master Offsets and Vave Offsets both perform all of the

necessary setup functions. The main difference between the two
procedures is that Valve Offsets allows you to perform the entire process
one step at atime. Calculate Master Offsets walks through the entire
process from start to finish.
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To perform a Valve Offsets procedure:

In the FMW Main Window, click on Configuration.
Click on Needle Setup, and select Setup Parameters.

In the Setup Parameters dialog box, shown in Figure 6-5, select Valve Offsets in the
Machine Setup Process section of the dialog box.

4. Click on 0K.
,@5 NOTE If you are changing from Calculate Master Offsetsto Vave
Offsets, it is recommended that you exit FMW and restart FMW
before continuing this procedure.

5. Click on Needle Setup on the Configuration menu again, and select Valve Offsets.
» The Setup Valve Offsets dialog box, shown in Figure 6-6, opens.

Setup Valve Offsets E3

-
-
-
-
-
-

Figure 6-6
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10.

11

13.

14.
15.

16.

Click on Run next to 1. Teach Purge Location.

;’T\ The dispensing head will move after your response.
» Thedispensing head Finds Home, then moves to the Purge Station location. A
Teach Window opens.

Use the Position Controls to dign the needle tip to the purge boot opening at the
Purge Station.

Activate the Z-axis controls and lower the needle tip into the purge boot.
Click on Teach.
Click on Done.

»  The Teach Window closes and you return to the Setup dialog box. Notice that
the box next to number 1 now has an X iniit to indicate that Step 1 has been
completed.

Click on Run next to 2. Teach Scale Location.

ff.\ The dispensing head will move after your response.

» Thedispensing head moves to the Weigh Station location. A Teach Window
opens.

. Use the Position Controls to aign the needle tip to the opening in the Weigh Station

lid.

Activate the Z-axis controls and lower the needle tip into the opening.
Click on Teach.

Click on Dane.

»  The Teach Window closes and you return to the Setup dialog box. Notice that
the box next to number 2 now has an X in it to indicate that Step 2 has been
completed.

Click on Run next to 3. Calculate the needle-to-Height Sensor Z offset or 3. Calculate
Valve2 to Valvel Z Offset, depending on your setup. This calculation accounts for the
following possible pump/Height Sensor configurations:

Single pump with Height Sensor

Dual pumps with Height Sensor (you will be prompted to perform this routine
twice, once for each pump)

Single pump without Height Sensor (do not perform this routine; skip to Step 25)

»  Onceyou have clicked on Run, a Teach Window opens. The dispensing head
moves to a Safe Z Height. The Height Sensor probe drops.

6-20
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»  For dua pumps without Height Sensor (Calculate Valve2 to Valvel Z Offset),
perform the following procedure.

a. Click on Run next to 3. Calculate Valve?2 to Valvel Z Offset.

Don't worry about selecting Vavel or Vave2 in the radio box. Either
pump can function as the basis for the calculation.

A Teach window opens.
b. Activate the Z-axis controls.

c. Lower the dispensing head until the needle tip on Valvel just touches the
white circle on the dispensing surface.

d. Click on Teach.
A Teach window opens.

e. Lower the dispensing head until the needle tip on Vave2 just touches the
white circle on the dispensing surface.

f. Click on Teach.
g. Click on Done to accept the results.

h. The Teach window closes, and you return to the Setup dialogue box.
Notice that the box next to number 3 now has an X in it to indicate that
Step 3 has been completed.

17. Check to make sure that the probe tip is lower than the needle tip.

» If the probetip is not lower than the needle tip, refer to the Height Sensor
section of the Operations Manual for probe height adjustment instructions.

18. Use a soft cloth to wipe the needle tip clean of any residua fluid.
19. Click on Next.

;‘T\ The dispensing head will move after your response.

20. Do one of the following, depending on the type of Needle Sensor installed on your
system:

a. For NSZ Series Needle Sensor, use the Position Controls to aign the Height
Sensor probe with the Load Cell on top of the Needle Sensor.

b. For NS Series Needle Sensor, use the Position Controls to align the Height
Sensor probe with the white dot on top of the Needle Sensor.

» If you are not sure what type of Needle Sensor is on your dispensing
system, refer to the Needle Sensor section of the Operations Manual for
help.

21. Click on Teach.
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23.

24.

25.

26.
27.

28.
29.

3L

32.
. Click on Next.

. Use the Position Controls to align the needle tip with the same circle or with the

Load Cdll, depending on your type of Needle Sensor.

» For NSZ Series Needle Sensor, DO NOT TOUCH THE LOAD CELL with
the needle tip. Center the needle tip over the Load Cell.

» For NS Series Needle Sensor, TOUCH THE NEEDLE TIP TO THE
SUBSTRATE.

Click on Teach.

»’('\ The dispensing head will move after your response.

» Thedispensing head automatically performs a height sense.
Click on Done to accept the resullts.

»  The Teach Window closes and you return to the Setup dialog box. Notice that
the box next to number 3 now has an X in it to indicate that Step 3 has been
completed.

Click on Run next to 4. Teach Safe Z.
» A Teach Window opens.
Activate the Z-axis controls.
Raise or lower the dispensing head to a Safe Z Height.

» SafeZ Height is determined by choosing a height that ensures that the needle
or any other part of the dispensing head does not come in contact with any
obstacles while traveling anywhere around the dispensing area.

Click on Teach.
Click on Done.

»  The Teach Window closes and you return to the Setup dialog box. Notice that
the box next to number 4 now hasan X in it to indicate that Step 4 has been
completed.

. Click on Run next to 5. Calculate the needle-to-camera XY offset.

» A Teach Window opens.

»  During this step of the procedure, you will dispense four dots onto a sample
substrate, then align the needle to the dots.

» You do not actualy have to dispense fluid during this procedure. Y ou can
simulate four dots in the shape of a square on a piece of paper.

Place a sample substrate, or a piece of paper with four dots in the shape of a
sguare, in the indented square on top of the Needle Sensor.

» |If you have aNSZ Series Needle Sensor, there should be a smulated
substrate aready present on top of the Needle Sensor.

Select aDot Style in the bottom of the Teach Window.

6-22

Setup and Configuration



&

37.

4]1.
42.

Use the Position Controls to center the Height Sensor over the first dot location.
Click on Teach.
Answer “Yes’ if you are asked if you want to re-teach the reference dots.

» Noticethe Enable Verification Step in the bottom of the Teach Window.
Enabling this feature activates a distance tolerance for later testing the needle-
to-camera offset. Refer to the on-line help for more information.

Use the Position Controls to center the needle tip over the first smulation dot as
shown in the on-screen prompt.

Click on Teach.
Repeat the previous 2 steps for the other three dots.

»  Once you have taught the location of al four dots, the dispensing head moves
to the Purge Station and purges, then moves immediately back to the sample
substrate and dispenses al four dots. Y ou are then asked to align the camera
crosshairs with the dots.

If necessary, use the Position Controls to center the camera crosshairs over the first
dot.

Click on Teach.
Repeat the previous 2 steps for all four dots.

» If youareusing the Enable Verification Step feature, and you had to redlign
the camera to the dots, you may be asked to re-teach the dots if the
verification tolerance was exceeded. Refer to the on-line help for more
information.

. Click on Done to accept the results.

»  The Teach Window closes and you return to the Setup dialog box. Notice that
the box next to number 5 now has an X in it to indicate that Step 5 has been
completed.

. Click on Run next to 6. Calculate the camera-to-Height Sensor XY offset.

f{'\ The dispensing head will move after your response.

» A Teach Window opens.

. Choose an easily identifiable mark on the sample substrate, such asadot or aline

intersection, and use the Position Controls to center the Height Sensor probe tip on
the selected mark.

. Click on Teach.
47.

Use the Position Controls to center the camera crosshairs over the same sdlected
mark, if necessary.

. Click on Teach.
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49. Click on Done to accept the results.

»  The Teach Window closes and you return to the Setup dialog box. Notice that
the box next to number 6 now hasan X in it to indicate that Step 6 has been

completed.
g NOTE If your dispensing system is equipped with adua action
dispensing head, you must also perform a complete Valve
Offsets for the second valve.
50. Click on Done.

This concludes the tutorial on Valve Offsets.
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Programming Setup

Before you begin programming sessions, it is recommended that you perform a Prompted
Setup procedure in addition to the Calculate Master Offsets or Valve Offsets procedure.
Also, before creating a dispensing program, you should visit the Configuration menu to setup
your workpiece and fluid file, which is used to keep track of fluid characteristics and

statistics.

Fluid Files

Fluid files record information about the dispensing fluids used in your programs. If all of your
dispensing programs use the same fluid, you can attach the same fluid file to al of the
programs. However, a different fluid file should be created for each type of fluid used. Fluid
files are stored in the Fluid folder under the FMW root directory as <f i | enane>. fl u

files.

g NOTE Remember, if you attach a single fluid file to more than one dispensing

program, changing the fluid file will affect al of the dispensing programs to
which it is attached.
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To setup a fluid file:

1. Inthe FMW Main Window, click on Configuration.
2. Select Setup Fluid Manager.
» TheHuid Manager dialog box, shown in Figure 6-7, opens.

Figure 6-7

3. Consult the On-line Help for detailed ingtructions.

This concludes the tutorial on fluid files.
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Sample Programming Setup

The following exercise will take you through a recommended programming setup. As you
become more familiar with your system, you may want to modify this routine.

This routine includes:
Loading a board

Creating anew file

Attaching afluid file

Teaching Workpiece alignment

Teaching Workpiece fiducids

&S \ore

2 \ore

Y ou will need to have the Tutorial Board handy for this part of the exercise.

Y ou may want to review “Fiducia Detection” in Chapter 7 — Programming
Basics before performing this exercise, but it is not required.

To perform a programming session setup:

L

In the FMW Main Window, click on Configuration.
From the Configuration menu, select Setup Workpiece Alignment.

In the Workpiece Alignment diadlog box, choose Learn Workpiece Angle first and Two
Fiducials.

>

Sdlecting Two Fiducials meansthat you will first define two diagonally-spaced
fiducials on the workpiece to define the location and aignment of the
workpiece. Before the program runs, FMW will check these fiducials.
(Checking for these fiducias is often eliminated when speed is a mgjor factor.
In that case, correct workpiece alignment and symmetry is assumed.)

Learn Workpiece Angle first isthe angle defined by the two points long a
sraight line on the board which will definean X or Y axis.

When defining the workpiece aignment, you may also be asked to define the
workpiece origin. The Origin is defined as the point where the position counters
are reset to (X,, Yo) = (0, 0) as shown in Figure 6-8. All dispensing locations on
the workpiece are defined in reference to the workpiece origin.

Optimizing the above parameters for a specific application is part of the
programming process.

Click on OK.
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11.
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Figure 6-8

Click on Configuration.

From the Configuration menu, select Setup Fluid Manager to open the Huid
Manager dialog box, shown in Figure 6-7.

Enter the information on the fluid you will be using for thistutoria (Hysol 4510 or
equivaent).

» ThePot Life should be documented in the material information data sheet.

» Itisrecommended that you disable Purge Maintenance for the tutoria
exercises. This means that the system will not automatically purge whilein a
production run mode and will not purge during programming. Or, set the option
for over 900 seconds so that your programming runs are not interrupted by
automatic purging while running test programs.

Click on Save.

» FMW takes you back to the Main Window.
Click on Teach a Program.

Select File from the Programming Window menu.
Select Fluid Table, and then Save As.

» SavetheFluid Fileasa<fil ename>. fl u file. Youwill atach thisfileto
your program later.

Click on 0K.
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13.

14.

15.
16.

17.

18.
19.

21

23.

Place the Tutoria Board as follows, depending on the type of dispensing system
you have:

A. For systems equipped with a conveyor, set the Tutorial Board (Side 1) at the
mouth of the conveyor. Use the dispensing system Conveyor Controls to set
the proper width. Choose Manual Load Board from the Run menu.

» Theboard isloaded into the dispensing area. The clamps should push the
board up to the bottom of the rail dot.

B. For gantry dispensing systems, place the Tutorial Board (Side 1) onto the heat
plate or dispensing area plate and fasten with the tooling pins.

In the Programming Window, click on Program Wizard to create a new
program.

» The Create Workpiece dialog box opens.

Choose Two fiducials.

Click on OK.

» A Teach Window opens asking you to teach the first point defining axis. This
will define the Workpiece Alignment.

Use the Position Controls to move the dispensing head to the start of one of the
Basic Lines near the top of the Tutorial Board.

» Center the crosshairs on the line.

Click on Teach.

Use the Position Controls to move the dispensing head to the end of the same line.
» Center the crosshairs on the line.

Click on Teach.

» You have just defined the Workpiece Alignment.

» The Teach Window changes, asking you to teach the Workpiece origin.

Use the Position Controls to move the dispensing head to the dot in the ULHC of
the Tutorial Board.

» Center the crosshairs on the dot.
Click on Teach.
Click on Done.

» The Teach Window changes again and you are asked to select a method for
teaching the first fiducial.

g NOTE Y ou may want to review the “Fiducia Detection” information in

Chapter 7 — Programming Basics before continuing this exercise,
but it is not required.
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24. Select Model Finder.
25. Click on Next.
» Teach thefirst fiducid in the same location where you taught the origin.

» If the dot does not fit entirely inside of the square overlay in the video display,
you will need to adjust the size of the Modd Window. Notice the Model Size
Width and Height text boxes in the area below the video display.

26. Click onthe up arrows next to the Width and Height text boxes to adjust the size of
the Model Window until the square is larger than the dot.

27. Click on Teach.
28. Click on Next.
» You are asked to select a method for teaching the second fiducial.
29. Select Model Finder.
30. Click on Next.

31. Use the Position Controls to move the dispensing head to the dot in the LRHC of
the Tutoria Board.

» Center the crosshairs on the dot.
32. Click on Teach.
33. Click on Next.

» The Teach Window closes and a message box opens, indicating that the
dispensing head is about to move to the Workpiece origin.

;’T\ The dispensing head will move after your response.

34. Click on 0K.

» The dispensing head moves to the location where you defined earlier asthe
Workpiece origin.

Click on File in the menu bar and select Save As.

&

36. IntheFile Name text box, type the name of the file.
37. Activate the Attach Fluid File(s) festure by clicking on it.

» FMW will attach the currently active fluid file, in this case, the fluid file you
created earlier in this exercise, to the newly created program file.

38. Click on Ok.

» Thefilewill automatically be saved in the Program folder under the FMW root
directory as<fi | ename>. f mw.

39. You havejust created a new Workpiece and are ready to begin programming.

This concludes the tutorial on Programming Setup.
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Prompted Setup

Prompted Setup is generally the most frequently used setup procedure. It should be
performed prior to all production runs, after changing the needle or valve, and if you are
experiencing inaccurate dispensing.

g NOTE If you have a DP-2000 Dispensing Pump installed on your system, you will

need to use FMWTools to configure your dispensing system for the
DP-2000 before running a Prompted Setup. Please contact Asymtek
Technica Support for more information.

gNOTE If you have a Dua-Action or a Dual-Bracket dispensing head, it is
recommended that you use the Scripted Prompted Setup described below.

To perform a Prompted Setup routine:

1. Inthe FMW Main Window, click on Configuration.
2. Select Prompted Setup Options from the Configuration menu.
»  ThePrompted Setup Options dialog box, shown in Figure 6-9, opens.

Asymtek FmNT - Prompted Setup Options

# Mon-Scripted Prompted Setup

(" Scripted Prompted Setup

[ Password Protect Setup Change

Current Script File:

‘ Select Scrpt File ‘

‘ oK ‘ ‘ LCancel ‘ ‘ Help ‘
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10.
11.

13.

14.

15.

16.

Figure 6-9

Select Non-Scripted Prompted Setup.
»  Scripted Prompted Setup is described below in the next section.
Click on OK.
In the Main Window, click on Run a Program.
From the Production Window, click on Setup, then click on Prompted Setup.
» A Teach Window opens.
Make sure that the dispensing areais clear of obstacles.
Click on Next to continue.
f?\ The dispensing head will move after your response.
»  Thedispensing head Finds Home and moves to an area behind the service
stations.
Change the plastic cups inside the Purge and Weigh Stations as prompted.
Click on Next to continue.
Check to make sure the purge boot is clean, or change it if necessary.

Click on Next to continue.
r‘(?\ The dispensing head will move after your response.

Install a new Needle and Shield. (The Shield is an optiona feature for cooling the
dispensing fluid.)
Click on Next.

» |If Caculate Master Offsetsis selected in the Needle Setup Parameters dialog
box, see Figure 6-5, then FMW prepares to perform a Find Needle XY Z
procedure next.

» If Valve Offsetsis selected in the Needle Setup Parameters dialog box, then
FMW prepares to perform a Valve Offsets procedure next.

Click on Done to prepare for either the Find Needle XY Z or the Valve Offsets
routine.

» For Find Needle XY Z, refer to the Calculate Master Offsets tutorial earlier in
this section for assistance, if necessary.

» For Vave Offsets, refer to the Vave Offsets tutoria earlier in this section for
assistance, if necessary.

Once the Find Needle XY Z or Vave Offsets procedure is complete, you will be
asked to test the vacuum at the Purge Station. Test the vacuum by placing your
finger over the purge boot opening to detect suction.
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17.

18.
19.

21

23.
24,

25.
26.

27.

28.

» If nosuction is detected, contact Asymtek Technical Support.
Click on Next.

»  The Operator Name dialog box opens.
Typein your name.

Click on Next.

» A dialog box opens asking if you intend to install a new syringe. If you answer
“Yes’, proceed to the next step. If you answer “No”, skip to Step 27.

Fill in al of the requested fluid information.

»  Consult the documentation that is packaged with the fluid for Thaw Time and
Lot Number information.

If your system is equipped with alow fluid sensor, activate the Enable Low Fluid
Check feature.

»  Boards After Low Fluid Sense is the estimated number of boards that can
completed before the run is paused and the syringe is changed. Consult the
On-line Help for more compl ete information.

Click on 0OK.
ﬁ\ The dispensing head will move after your response.
»  Thedispensing head moves to the front center of the dispensing area for
syringe ingtdlation.
Press Pause on the Dispenser Control Panel.
Change the syringe.

» Refer to the manua specific to your valve for syringe replacement
instructions.

Press Pause on the Dispenser Control Panel again to rel ease the pause.
Click on Next.

rf?\ The dispensing head will move after your response.

The dispensing head moves to the Purge Station and prepares for a Flow Rate
Cdibration.

Follow the on-screen prompts.

This concludes the tutorial on Prompted Setup.
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Scripted Prompted Setup

Prompted Setup can be tailored into a Scripted Prompted Setup to meet your specific setup
requirements. FMW includes severd pre-programmed valve-specific scripted setup
procedures that can be used for production run setup, or you can create your own script.

,@ NOTE For information on creating your own scripted prompted setup, refer to the
On-line Help.

To perform a scripted Prompted Setup:

1. Inthe FMW Main Window, click on Configuration.
2. Select Prompted Setup Options from the Configuration menu.

»  ThePrompted Setup Options diaog box, shown in Figure 6-9, opens.
3. Select Scripted Prompted Setup.

» FMW includes severa valve-specific scripted setup procedures. Consult the
On-line Help for instructions on selecting a different script file.

Click on OK.

In the FMW Main Window, click on Run a Program.

In the Production Window, click on Setup.

Click on Prompted Setup.

»  The scripted Prompted Setup dialog box, shown in Figure 6-10, opens.

N o o A~
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Current Script Filename: A_DVEK

Task Description

Move Head to Center

Check Purge and Weight Cup
Check Purge Boot

Move Dispenser head to front
Inztall new Needle

Teach 5afe 2

Teach Purge Location

Teach Scale Location

Move Valve to Purge location
Turn Yacuum ON

Test Vacuum

Turn ¥acuum OFF

Dperator Mame

Syringe Data

Move Front

Install Syringe =

Inztructions

Clear work Area. Dizpenser will find home.

Asymtek FmNT - Machine Setup

® Yalve 1

| Valve 2

Bun to End

Single Step

Reset

Select File

Help

Exit

Figure 6-10

8. Follow the on-screen prompts. Consult the On-line Help for assistance, if necessary.

» Each step must be performed in the order that it is listed.

»  Scripted Prompted Setup alows you to run each step of the procedure one

step at atime, or from start to finish.

»  Scripted Prompted Setup is also capable of running customized script files.

Conault the On-line Help for more information.

&S NoTE

This concludes the tutorial on Scripted Prompted Setup.

If you have a Dual-Action or a Dual-Bracket dispensing head, the second
valve must be selected and Scripted Prompted Setup must be run again.
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Manual Setup

There are several manual operations that you can perform at any time. These are listed in
Manua Setup.

To view the Manual Setup options:
1. From the Main Window, click on Run a Program.
2. Click on Setup.

3. Note the setup options listed in the drop-down menu.

» Any of the setup options can be performed individualy by double clicking on
the option name.

This concludes the tutorial on Manual Setup.
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7 Programming Basics

Overview

This chapter introduces the fundamental's of developing dispensing programs in FMW. These
skills prepare you for more complex programming in the next two chapters.

It is essentid to be familiar with the tools you will use to program, such as the Vison System
software. This chapter explains the use of Model Fiducia Finder and Corner Finder in the
Vision System. Y ou will be taught basic tips on how to define and recognize good fiduciads
and how to set up for edge detection.

The following subsections provide guidance on how programs are built in FMW and aso
what tools are used to create them. Read this section before going on to programming. Part
of this exercise requires use of the Tutoriad Board and FMW. Y ou will not be dispensing, but
you will be using the board.

Estimated time to complete: 60 minutes

Theory and Use of Programs

All complex dispensing systems require software programs to control the dispensing system
components. The software controls the flow of fluid, temperatures and motion by controlling
the individual components of the system. FMW controls dmost al of the dispensing system
components.

Programs are written for specific dispensing applications on specific dispensing systems.
Typicdly, a program written on one dispensing system must be modified dightly before it can
deliver the same degree of accuracy on another system. Therefore, it isimportant to write
the program on the same machine that will run the program.

Programs are composed of command ingtructions like any other machine-control program.
The ingtruction lines are cryptic, but can be easily identified. Commands can contain location
instructions, telling the dispensing head where to move, when to start dispensing and in what
shape, instruct the system to check fluid flow rate or temperature, to purge, and where to
look for and how to find fiducias. Basically, any function you want performed during a
dispensing run should appear as a command somewhere in your program.
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For example, the first level of a multipass underfill program might look like thisin FMW:

PURGE: AT PURGE FOR 2 secs
LOOP PASS: FROM 1 TO 2

DO MULTIPASS

DO MULTIPASS

DO MULTIPASS

DO MULTIPASS

NEXT LOOP:
END:

: 50mgline AT [7.754, 11.009)
DO MULTIPASS:

50mgline AT [10.751, 11.011)

: 50mgline AT [13.757, 11.010)
DO MULTIPASS:

50mgline AT [16.756, 11.013)

: 50mgline AT [16.751, 8.098)
DO MULTIPASS:

50mgline AT [13.758, 9.008)

: 50mgline AT [10.746, 9.000)
DO MULTIPASS:

50mgline AT [7.749, 8.991)

Thefirst line of the program is a Purge command. The dispensing head will move to the
Purge Station and purge the vale for two seconds. The second command and the 11™
command form a multipass loop, which means that commands 3-10 will execute in order a
defined number of times, in this case twice, as defined in line 2.

Commands 3-10 are calling a separate program, titled “Multipass’, and telling it to execute at
the (X,Y) coordinates at the end of each line. Thiswill be explained in greater detail in later

chapters.
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Building a Program in FMW

It isimportant to learn how to build programsin FMW. Complex multipass dispensing
programs are built by first defining patterns, then adding those patterns to the whole
workpiece.

When building programs, it is important to keep in mind that you want to develop the fastest
method of dispensing in order to maximize production throughput. Y ou gain this efficiency by
constructing the patterns and adding them to the program in the most time-effective manner.
Also, limiting the number of times fiducial searches or other processes such as flow rate
measurements and purging are performed can increase throughput. The optimization comes
in figuring out how to add these processes to your program without compromising accuracy
or throughput.

In the next sections and the following chapter, you will be taught basic skills that will enable
you to successfully build efficient dispensing programs.

Workpieces, Patterns and Procedures

An understanding of the difference between workpieces, patterns and procedures in FMW is
essentia for programming.

A “workpiece’, as defined by FMW, is usually your board or auer boat. Master Fiducids, if
present, are taught on the workpiece.

“Patterns’ are dispensing patterns, such aslines or a set of dots, that are repeated at several
locations on a board. The patterns are “ placed” --meaning programmed-- onto the workpiece
at defined locations.

Any dispensing command that can have fiducias is a pattern. Other dispensing commands
are “procedures’. The Main Procedure is a set of commands usually hidden from the
Programming Window.

Patterns can also contain “ nested patterns’ or subpatterns. Subpatterns are defined as a new
pattern, then “placed” within another pattern. The parent pattern can then be “placed” on the
workpiece.

For example, aprogram titled “Workpiece” is an underfill dispensing program for an auer
boat containing ten chips. Each chip requires the same dispensing pattern. Y ou would first
define the underfill pattern for one chip and save it as a separate pattern titled “Lfill” for
example. The “Lfill” pattern is then taught at each of the ten chip locations on the auer boat
to create the “Workpiece” pattern.
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Look at the following program ingtructions in Figure 7 -1. Specific pattern program lines are
displayed separately. Only the ingtructions for the currently selected pattern are displayed in
the programming screen. As shown, the currently selected pattern is Workpiece. The
instructions for Workpiece shown in the programming screen are function calsto a
sub-pattern caled Chip 1. To display the instructions for Chip 1, you would select Chip 1 from
the Pattern Name Text Box.

= Asymtek Fluidmowve - Programming Window
File Edit Program Setup RBun View Help

EEEIEIEER DR OGN EEEE

Program: SUITEZ.FMW Fluid:' FMW.FLU Pattern Name: WDrkpiege :I

Il DO: chipl AT [2.450, 1.297) / =
2 DO: chipl AT [3.489, 1.300) Pattern Name Di;ﬂgg@mm
3 END: Text Box

i

Comments

&~

Send ACL

Pattern Function call to do
“Workpiece” pattern “chipl” at
Instructions this location.
Pattern

LINE: 1, Start:(0.000, -0.036], End:{0.407, -0.036]
LINE: 1, Start:(0.407, -0.036), End:(0.407, 0.274)
WEIGHT CONTROL: 10.000, 1, ...

END:

“chipl”

IEll MOVE TO LOCATION: PURGE
2
. 3
Instructions 4
5

Figure 7 -1
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The Vision System

An essential component of the programming and production process of fluid dispensing is the
Vision System. The Vision System hardware consists of a camera, light source, Cognex”

Vision Processor and video board. The software portion includes Fluidmove for WindowsO

(FMW) which controls al programming and dispensing functions and uses the Asymtek

Vision for Windows (AVW) library in conjunction with Cognex software to perform fiducial

location and edge detection functions. The video image you see in the Teach Window is
supplied by the Vison System. Figure 7 -2 is ablock diagram showing the interaction

between the components of the Vision System.

ee

(Cugnex Driver $thware)

Lights fi' ) Computer

- Cognex \

Camera Board

-
Video Mixer Board

Manitor
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Fiducial Detection

The Vision System has three tools or methods to find fiducials as described below. The
exercises that follow will teach you how to use these tools. The first exercise will use the
Mode Finder method to define Workpiece fiducias. The second exercise will use the Corner
Finder method to define a pattern fiducial. Defining Workpiece and pattern fiducials are the
crucia first steps to creating any dispensing program.

Since the Manual Finder method is only used under specid circumstances, and is taught
exactly likeaMode Fiducia, you will not perform aManua Fiducial exercise.

Model Finder

This method uses pattern recognition to find a previoudy defined gray-scale mode, which is
the defined fiducia in the field of view. Thistype of detection is used with modd fiducials as
described in the section “Model Fiducias’.

Corner Finder

This method uses edge detection dgorithms to find the corner of a previoudy defined part in
the field of view.

Manual Finder

This method is used mainly on dispensing systems equipped with the AV-700 Vision System.
Manua Finder uses modd fiducias which are manualy taught every time afiducia searchis
performed.

Model Fiducials

Fiducias can be used to define the dimensions and position of the workpiece, or identify the
location of parts on aworkpiece. Part of the programming process is to determine which
fiducias should be defined to achieve the accuracy and speed required for your dispensing
process. Modd fiducias are usudly letters, dots, or silk-screened marks on a circuit board.

Selecting Good Model Fiducials

In order to be effective indicators of workpiece location, fiducials must be unique and easily
distinguished from all other features and artifacts on the workpiece. Fiducias are selected
according to shape, position and use.

Size and Shape: The shape of afiducia determines whether the fiducial is recognizable
under trandation or rotation. Fiducials should be recognizable as the same shape even if
rotated or trandated. Below in Table 7 -1 are some types of fiducials and their rating.

The maximum size of the Modd Window in FMW is 200 x 200 pixels (100 x 100 mils on the
part). Fiducials must be smaller than that in order to be used, unless a portion of the fiducial
element can be used to represent the whole fiducial. Large fiducias take longer to find.
However, if the fiducid istoo small, other artifacts or contamination in the Search Window
on the workpiece might be misinterpreted as a fiducial.
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Table 7 -1 Fiducial Ratings

Shape Characteristics
O donut Excellent. Immune to rotation. Inner and outer diameters allow for further
definition.
# pound Good. Uniqueness maintained under rotations.
® circle Good. Immune to rotations.

O hole/gap | Poor. Requires machining accuracy to match definition. Not repeatable
between different workpieces.

E cross Poor. Single axis identification does not allow for poor quality printing of the
shape.

Uniqueness: While afiducia must be a unique feature on the workpiece, the fiducial must
appear the same on al similar workpieces. The fiducial includes the feature and the
background. This means that the same shape on two workpieces with different backgrounds
will not be identified as the same. See Figure 7 -3 for examples of good fiducials.

The uniqueness of afiducid is often defined by its proximity to other elements on the
workpiece. A circle might be a repeated pattern on a workpiece, but a circle next to
rectangle might be unique to the location you are trying to define. This type of identification is
more common when defining nested pattern fiducias, rather than workpiece alignment
fiducias.

Contrast: The ability to enhance the contrast of the fiducia to the background can be
optimized by Vision System parameters. However, you should choose a fiducid that has good
natural contrast from the background.

While the selection of afiducid is unique to a workpiece, the following figures show good
fiducias as far shape, background, size and contrast.
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Metal Dot

Search Fiducial

Window

Outer Contrast
Ring

Model Window—

Metal Dot
Fiducial on Dark
Background

Donut Fiducial
with High
Contrast
Rarknarniind

Shaped Fiducial
Pattern

Figure 7 -3
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To teach a model fiducial:

o a0k~ W

~N

10.

11

13.
14.

In the FMW Main Window, click on Teach a Program.

Load the Tutorial Board (Side 1) as follows, depending on the type of material
handling option your system has:

A. For systems equipped with conveyors, set the Tutorial Board (Side 1) at the
mouth of the conveyor. Use the dispensing system Conveyor Controls to set
the proper width. Choose Manual Load Board from the Setup menu or click on
the Load Board icon.

» Theboard will be loaded into the dispensing area. The clamps should push
the board up to therails.

B. For gantry dispensing systems, place the Tutoria Board (Side 1) in the
dispensing area and lock down with the tooling pins.

Click on Main in the toolbar to return to the Main Window.
Click on Configuration.
Select Setup Workpiece Alignment.

In the Workpiece Alignment dialog box, select Two Fiducials and Learn Workpiece
Angle first.

Click on OK.

In the FMW Main Window, click on Teach a Program.

In the Programming Window, click on File and select New.

» The Teach Window will open and ask you “Teach first point defining axis’.

Using the Position Controls, move the dispensing head to the beginning of one of
the Basic Lines and click on Teach.

Using the Position Controls, move to the end of the same line and click on Teach.

»  The points need to be definable along the same X-axis, such as dong a silk-
screened line. By defining these points, you have defined the X-axis of your
workpiece.

» You are then asked to “ Teach workpiece origin.”

» Theworkpiece origin is the point you want the system to define as (0,0), and
will be the starting reference point when positioning dispensing commands and
patterns on the workpiece. It can also serve as the location for the first fiducia
if you choose.

Using the Position Controls, move the dispensing head to the LLHC of the tutorial
board and center the crosshairs on the dot below Flip Chip 1.

Click on Teach.
Click on Done.
» Now you are asked to select the method for defining the first fiducial.
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15.
16.

17.
18.

19.

21.

>

Notice the choices for fiducia finding offered below the video display window.

Select the Model Finder method.
Click on Next.

4

Notice the white-lined box in the video display window. Thisis the Model
Window, the area which will be defined as the fiducial.

For our firgt fiducial, we are going to use the same dot we used to define the
workpiece origin.

Using the Position Contrals, align the camera crosshairs with the center of the dot.

Adjust the Model Size parametersif necessary.

>

The Model Window should be as small as possible, but dightly larger than the
fiducial feature.

Y ou may want to use one haf of the dot or a quarter of the dot as the fiducial.
If the fiducid fills the entire Modd Window, it is not a good fiducid.

Adjust the Search Window parameters if necessary.

>

The Search Window is the areain which the Vision System will search for the
fiducid.

The default values for the Search Window parameters are equa to the
dimensions of the video display window.

Adjust the Accept and Confusion Thresholds if necessary.

>

Accept Threshold is aminimum “score” that a feature must meet or exceed to
be considered a candidate for the desired fiducia. When the vision system
finds a potential fiducia, it assigns a score to the feature based on the contrast
in the grey-scale. If the score of the potential fiducial does not meet or exceed
the Accept Threshold, the vision system will automatically disregard the
feature and continue searching. Recommended setting: 500-800.

Confusion Threshold is the maximum score assigned to a“wrong” featurein
the field of view. If multiple features are being considered as a possible
fiducial, afeature that scores greater than the Confusion Threshold will
automatically be accepted as the fiducia. A feature that scores equal to the
Confusion Threshold will be accepted, but only if a higher scoring feature
within the field of view can not be found. The Confusion Threshold should be
set greater than or equal to the Accept Threshold. Recommended setting:
500-900.

Click on the Run Time tab.
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» “Check for location tolerances’ means that FMW will check the found
location of the fiducial and compare it to the location where it expected to find
it. If the difference between the two locations is greater than the Location
Tolerance, FMW will consider the fiducid to be “Not Found.” This ensures
that an incorrect fiducia is not considered to be a correct fiducia, and
prevents dispensing on parts that are too far away from their expected
locations.
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22. Click on the Image tab.

» Readthe QTIP section on “Gain” below.

.

The Gain controls the way digital values are assigned to
the analog signal from the camera. Lower Gain values will
increase the contrast of the image and may help to
differentiate the fiducial from the background. However, a
low Gain value may also amplify “noise” in the image.
Therefore, it is recommended that you first adjust the light
level, then adjust the Gain only if necessary.

Gain

The default value of the Gain is 255.

23. Click on the Mode Finder tab.
24. When you are satisfied with the fiducid, click on Teach.
25. Test thefiducia by clicking on Find Fid.

» The Test Resultsindicate if the fiducia was found or not, its found
coordinates, how sure the system is that it has found the correct fiducial, and
how long it took to locate the fiducid.

26. Click on Next to accept the results.

27. Using the Position Controls, move the dispensing head to URHC of the tutorial
board, center the crosshairs on the dot in the URHC, and repeat Steps 1526 to
teach the second fiducial.

»  Once you have completed teaching the second fiducia, you will have
successfully taught the Workpiece fiducias.

28. Continue to the next section and use Corner Finder to teach the pattern fiducials.

This concludes the tutorial on Model Fiducials.
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Corner Fiducials

Corner Finder is an aternate method provided by the Asymtek Vision System to identify
fiducials that are part edges or lines or edge pairs, such as the edge of adie. In some cases
accuracy is grestly improved by identifying the part to be dispensed on as afiducial.

The position of parts can be dightly rotated by automatic placement systems, or the parts can
be didodged during the solder reflow process. To compensate for the possibility of part
misplacement, Corner Finder offers afeature called Orthogonality Tolerance. Y ou will notice
this feature as one of the options when defining a corner fiducia. Orthogonality Tolerance is
aplus or minus value that FMW uses to determine if a part is square. When defining a corner
fiducia, FMW measures the angle of the corner. If the corner is within 90° plus or minusthe
Orthogonality Tolerance, the part is considered to be square. If the angle is outside of the
Orthogonality Tolerance, FMW issues a Fiducia Error message which gives the operator the
option of skipping the part or redefining the fiducia.

The Corner Finder method assumes that edge images are a changein gray vaue from light to
dark or dark to light. Edges are identified by locating these types of gray changes and
analyzing them datistically to seeif they meet a given criteria. The programmer can set the
search areajust like with Gray Scale. Corner Finder uses avision tool caled a Caliper
designed to find edges or pairs of edges.

Selecting Good Edges

The same rules for size, uniqueness and contrast in selecting model fiducids appliesto edges
and corners. Edges must be easily distinguishable from the background so that

dark-to-light or light-to-dark trangitions are maximized. The Light Level and Gain settings can
be adjusted to increase this contrast. Edges should also be as “clean” and straight as possible,
even though the software uses an averaging agorithm.
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Read the @TIP section “Light Level” below.

.

The Light Level controls brightness of the LED or fiber optic
lights directly. The vision system can have one or two light
sources. For finding the corner of a die on a board, one light
source may be better at casting the proper shadow onto the
board and producing the high contrast which is most easily
recognized by the Vision System.

Light Level

Light Level can be varied from 0O - 15.

For fiber optic lights, the light levels are incremented by two
and toggle between each light source. This means:

Level 0 corresponds to Light Source 1 at Level 0.
Level 1 corresponds to Light Source 2 at Level 0.
Level 2 corresponds to Light Source 1 at Level 2.

Level 3 corresponds to Light Source 2 at Level 2, and so on.

Caliper Tool

The Cdiper Tool has a Cdiper Window overlay on the image of the edge as shown in Figure
7 -4. Thetool is strategicaly placed over the edges to be identified. The tool can be sized in
2-dimensions. The Search Length is the longer dimension of the caliper tool and crosses the
edge to define the length of the areato be searched for the gray trangtions. It isimportant
not to include more than one transition or edge along this length. The Projection Length is the
shorter dimension, the distance that the application will average grey-scale values down the
edge in order to reduce noise and enhance the transition.

The calipers are applied perpendicular to the edges as shown in Figure 7 -5. The information
obtained by “averaging” the gray values of the pixesis caculated and the light-to-dark or
dark-to-light transitions are identified. The steeper the slope of the curve defining the edge,
the more well-defined the edge is.
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When using asingle fiducia with Orthogonality Tolerance, FMW calculates the angle of the
corner defined by the calipers. If the corner is within the Orthogondity Tolerance, the part is
considered square and dispensing on the part will be performed. For example, if the
Orthogondity Tolerance is set at 5, and the corner fiducia is determined to be 85-95 degrees,
FMW considers the part to be square. However, if the corner fiducia isless than 85 degrees
or more than 95 degrees, FMW will issue an Orthogonality Tolerance warning and you can
choose to skip the part or redefine the fiducial.

Search Length

Projection Length

Application Point

Figure 7 -4

Multiple Calipers M

Figure 7 -5
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25 NOTE  You should first perform the preceding tutoria on Model Fiducias before
performing the following exercise.

To use Corner Finder to locate an edge:

1. Inthe Programming Window, click on Pattem on the Program Commands toolbar.
2. Select Create Pattern.
»  The Create Pattern dialog box opens.
3. TypeSample in the text box and choose One fiducid.
4. Clickon 0K.
» A Teach Window opens asking you to define the pattern origin.
5. Using the Pogition Controls, move the dispensing head to the LLHC of Hip Chip 1.
6. Click on Teach.
7. Click on Done.
» You are now asked to select the method for teaching the pattern fiducial.
8. Select Corner Finder.
9. Click on Next.
» Noticethe caipersin the video display window.
» Teachthefiducid in the same location as the pattern origin.
10. Using the Position Controls, move the dispensing head to the LLHC of Hip Chip 1.

»  Notice the green square in the area below the video display. Thisisthe
Quadrant Model, a representation of the part onto which you will dispense.
The highlighted corner of the quadrant should be the same corner where the
fiducid will be taught.

11. Click onthe LLHC of the Quadrant Moddl.
»  Thecdliper orientation will change.

12. Adjust the camera position so the edges of the flip chip run up and down the centers
of the calipers.

» Readthe @TIP section “Cdiper Sizing” below.
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@ TIP
Caliper Sizing

The Search Length should be optimized so that it contains only
one gray value transition (light to dark, dark to light). A longer
Caliper increases the range for finding the corner, but also
increases the chances for finding the wrong corner.

Projection Length controls the averaging for the transition
amplification. A wider Caliper is better for rough edges or
eliminating noise caused by traces on the board. Thinner
calipers are more immune to rotated parts.

Caliper Density controls how many calipers are used. More
calipers may help reduce the effects of edge irregularities, but
will take longer to execute. You should set the Projection Length
and Caliper Density such that you have at least five calipers
along the edge.

13. Adjust the Search Length and Projection Length if necessary.
14. Set the Edge Polarity to Light-dark.
15. Set Minimum Contrast to 2.

» Thisisthe lowest acceptable differencein grey-levels on opposite sides of the
edge to qualify as atransgition.

16. Set Caliper Density to 2.

» A lower value will space the calipers farther apart. A higher vaue will overlap
them more.

17. Click on Teach.
18. Test thefiducid by clicking on Find Fid.

» TheTest Reaultsindicate if the fiducia was found or not, its found coordinates
and how long it took to locate the fiducid.

19. Click on Done to save the results and end this tutorial.

This concludes the tutorial on Corner Finder.
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Editing Fiducials

Y ou can edit fiducias defined for your workpiece at any time. Y ou may want to edit fiducias
if the system fails to find too many of them during production runs. The procedure below isa
reference procedure. Do not perform it now.

To edit fiducials:
Using Model Finder

1. Load the workpiece board.

2. Inthe Programming Window, make sure that the name of the pattern containing the
fiducials you wish to edit appears in the Pattern Name text box.

3. From the Edit menu select Edit Fiducial Info.
» A Teach Window opens.
» Thedispensing head moves to the fiducial locetion.
4. Select Model Finder.
5. Click on Next.
Use the Position Controls to find your new fiducial.
» Adjust the Moddl Size parametersif necessary.
» Adjust the Accept Threshold and Confusion Threshold if necessary.

» Refer to On-line Help for definitions of Accept Threshold and Confusion
Threshold.

7. Click on Teach.
8. Testthefiducid by clicking on Find Fid.

» The Test Resultsindicate if the fiducia was found or not, its found coordinates,
how certain the system isthat it has found the correct fiducia, and how long it
took to locate the fiducid.

9. Click on Done.

This concludes the tutorial on editing fiducials.
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8 Beginning Programming

Overview

This chapter introduces you to the fundamental dispensing commands and patterns that form
the foundation of all dispensing applications. Y ou will learn how to create basic dispensing

patterns. Later in this chapter, you will learn how to place those patterns at multiple locations
on the same workpiece.

It is essentia for you to develop the basic programming skills in this chapter. These skills will
be further developed in the next chapter, “ Advanced Programming’”.

The estimated time to complete each tutoria islisted at the start of each lesson.

,€§ NOTE Y ou should complete the preceding chapter, “Programming Basics’ before
attempting the exercises in this chapter.
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Lines

Lines are a common dispensing element for flip chip underfill applications. Weight control
lines, which are lines whose fluid weight can be user-defined, are often used in that
gpplication. In this exercise, you will learn how to program and dispense smple lines.
Afterwards you will learn how to edit the lines.

Weight control lines are treated separately in the next section.

Estimated time to complete: 45 minutes.

Basic Lines

To do this exercise you will need to have an operational valve, needle and aloaded syringe of
fluid. The lines programmed in this exercise are to be placed on the workpiece pattern.
To program the lines:
1. Perform the Programming Setup in Chapter 6 - Setup and Configuration.
» Load Side 1 of the Tutoria Board.
»  When you create the Workpiece, define the Workpiece Alignment.
»  Choose No Fiducias.

2. Since you will not need the heaters for this program, click on Tools in the Main
Window.

In the Tools Window, click on Terminal.
4. Click on Heater.
» This accesses Heater Control for Windows.

»  Along the left hand edge of the window is a column titled On/Off. Double-
clicking on each section of this column will deactivate each heater |oop.

,Qf NOTE  The Hesater icon should be greyed-out when the loop is turned off.

5. Once you have deactivated each heater loop, click on FMW to close Heater Control
for Windows.

» Youmay haveto click on Exit in the Terminal Mode Window to return to the
Tools Window.

6. Inthe Tools Window, click on Main.
7. Inthe Main Window, click on Teach a Program.

8. Click on Dispensing Elements from the Program Commands toolbar.
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» A Teach Window opens.
9. Choose Line from the Dispensing Elements toolbar in the Teach Window.

10. Usethe Position Controls to move the crosshairs to the starting point of the first line
in the ULHC on the Tutorial Board.

11. Click on Teach.

12. Use the Position Controls to move the crosshairs across the line to the endpoint.
13. Click on Teach.

14. Click on Done.

»  Inthe Program Window, you should see the following:

X1,Y1 Coordinates of
| ine 1 Start Point

1 Line 1, Start: (12.264, 10.896), End: (13.290, 10.897)
2 END:

X,,Y, Coordinates of
line 1 Fnd Paint

» Your coordinate numbers may differ from those above.

15. Repeat Steps 8 - 14 to program the next two lines below the first line on the
Tutorial Board.

»  When finished, your program should look like this:

1 LINE: 1, Start: (X1, yl1), End: (x2, y2)
2 LINE: 1, Start: (X3, y3), End: (x4, y4)
3 LINE: 1, Start: (x5, y5), End: (x6, y6)
4 END:

Xn, Y are the coordinates of each point.
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16. Inthe Programming Window, click on Run and select Dry Run.

/‘\-\ The dispensing head will move after your response.

»  Waitch the video display as the dispensing head performs the programmed
commands. The camera will act as the needle and follow the lines, but no
dispensing will be performed.

@ If the lines were “dry dispensed” at an incorrect angle, you may need to re-
program the origin of the board and workpiece angle. Unfortunately, this
means you will need to start over defining this program.

17. In the Programming Window, click on Run and select Wet Run.
»  Watch asthe lines are dispensed.
»  Examinethe board for quaity and accuracy.

This concludes the tutorial on Basic Lines.
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Editing the Lines

If you were not satisfied with the lines dispensed, you can smply edit them. This exercise will
teach you how to edit existing lines in a program. For this exercise, you will shift the lines
over and shorten them.

To edit the lines (shift them over and shorten):

1
2.

5
6
7.
8
9

From the Edit menu in the Programming Window, select Edit Pattern.
Click on Workpiece.

ﬁ\ The dispensing head will move after your response.
Place the cursor on 1 LINE in the program and double-click.
» A Teach Window opens.

Use the Position Controls to move the crosshairs to the start of the first shorter line
in the set of shorter lines on the Tutoria Board.

Click on Teach.

Use the Position Controls to move the crosshairs to the end point of the next line.
Click on Teach.

Repeat Steps 3 - 7 for the other two lines.

Click on Dane.

10. Select Dry Run from the Run menu.

ﬁ\ The dispensing head will move after your response.

»  Watch to see the program run with the lines shifted over and shortened.

11. Select Wet Run from the Run menu.

»  Waich asthe lines are dispensed.
»  Examine the board for quaity and accuracy.

This concludes the tutorial on Editing Basic Lines.
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Weight Control Lines

Most lines for flip chip underfill applications are weight control lines. These are lines where
the programmer has greater control over specific characteristics of the line. A defined
amount (weight) of fluid is dispensed over a defined length of line or pattern.

Estimated time to complete: 45 minutes.

To view the customizable parameters for weight control lines:

1. Inthe Programming Window, click on Edit and select Edit Line Parameters.

» A didog box opensindicating the type of valve installed on your dispensing
system and which valve, Vave 1 or Vave 2, is currently active.

2. Click on 0K.

»  TheLine Parameters dialog box, shown in Figure 8-1, opens.

» Usethe horizontal

scroll bar to see dl the columns.

| Line Parameters : CAFMWAFLUIDWIHSFLU |

PreMove Dloy [Shiai Ditance] Dspensep | Sheed | | owell_toec

1 0.050 0.000 0.100 1.000 0.0

2 0.050 0.000 0.016 1.010 0.0

3 0.050 0.000 0.018 1.020 0.0

4 0.050 0.000 0.020 1.030 0.0

5 0.050 0.000 0.020 1.040 0.0

6 0.050 0.000 0.020 1.050 0.0

7 0.050 0.000 0.020 1.060 0.0

8 0.050 0.000 0.020 1.070 0.0

9 0.050 0.000 0.020 1.090 0.0
10 0.050 0.000 0.020 0.050 0.0
+ 1 [+

‘ (114 ‘ ‘ Save ‘ ‘ Cancel ‘ ‘ Help ‘
Figure 8-1

» Below are brief explanations of the parameters.
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Pre-Move Delay Factor

Some fluids have a high viscosity which means that they do not dispense as quickly as lower
viscosity fluids. The Pre-Move Delay Factor increases the time that the dispensing head is
parked with the valve ON, prior to a programmed move. The delay at the beginning position
insures that afull line is dispensed. The units are seconds. Typicaly, 50 ms (0.050 sec) is
sufficient for most underfill fluids.

Shut-Off Distance

This parameter controls where dispensing is discontinued at the end of amove. Low viscosity
fluids require that you stop dispensing prior to the end of the move so that the fluid does not
exceed the pattern limits. The Shut-Off distance is the point where the valve stops dispensing
before the end of the move. The units are in inches. Typicaly, 30 mils (0.030 in) is sufficient.

Dispense Gap

The Dispense Gap is the distance between the needle tip and the substrate during dispensing
operations. This distance is one of the more common adjustments made to optimize
dispensing programs. The units are in inches. Typicaly 15 - 20 mils (0.015 - 0.020 in) is
sufficient.

Speed

This refers to how fast the dispensing head moves during dispensing. This parameter is
actually not used for weight control lines, but basic lines where the speed of the dispensing
head affects the amount of fluid dispensed. The units are inches/second.

Dwell

This parameter is similar to the Pre-Move Delay Factor, except that it is used at the end of a
move. The Dwell is how long the dispensing head stays at the final position of a move before
retracting. This alows residua fluid to detach from the needle tip before the dispensing head
moves to the next location. The units are seconds. Typically, 0 - 20 ms (0.020 sec) is
sufficient.

Retract Distance

Thisisavertical distance that the dispensing head moves after the Backtrack Gap and
Backtrack Length dispensing commands have completed. Figure 8-2 shows the relationship
between Retract Distance, Backtrack Gap and Backtrack Length. The Retract Distance
must be within the Safe-Z Height defined in Initid Setup. The units are inches. Typically, 250
mils (0.250 inches) is sufficient.

Backtrack Gap

Thisisthe vertica distance that the dispensing head moves up after completion of a move. At
the end of a move, the dispensing head raises the Backtrack Gap, then moves the Backtrack
Length back over the line that was just dispensed. This encourages congealed fluids to detach
and distributes any excess fluid back across the line. The units are inches. Backtrack Gap
should be at least double the Dispense Gap.

Beginning Programming 8-7



Backtrack Length

Thisisthe horizontal distance that the dispensing head moves back over the dispensed line
after raising up the Backtrack Gap distance. This encourages congealed fluids to detach and
distributes any excess fluid back across the line. The units are inches. Typicaly, 30 - 40 mils
(0.030 - 0.040 in) is sufficient.

Backtrack Speed

Thisis the speed that the dispensing head travels when moving along the Backtrack Length.
The units are inches/second. Typicaly, 2 in/sec is sufficient.

Down Speed
The Down Speed is how fast the dispensing head lowers to dispense. Low viscosity fluids
tend to drip and you may want to set this parameter higher. The units are inches/second.
Typicdly, 2 in/sec is sufficient.

Down Acceleration

Thisis the parameter that controls how fast the dispensing head comes up to the Down
Speed. The units are inches/second?. Typically, 300 in/sec? is sufficient.

Retract Speed
Thisis the speed of the dispensing head while moving the Retract Distance. The unitsarein
inches/second. Typically, 2 in/sec is sufficient.

Retract Acceleration

Thisis the parameter that controls how fast the dispensing head comes up to the Retract
Speed. Y ou may need to set this high for small dispensing moves. The units are
inches/second?. Typically, 300 in/sec? is sufficient.

Suckback

At the end of dispensing aline or adot, the valve is reversed for the Suckback period to
remove any material from the tip of the needle. The Suckback value should be set according
to fluid viscosity. Generdly, 10 ms (0.010 seconds) is sufficient.

Backtrack Length

Retract Distance
Backtrack Gap

Figure 8-2

3. Click on 0K to close the Line Parameters dialog box and return to the Programming
Window.
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To program weight control lines:

1. Perform the Programming Setup in Chapter 6 - Setup and Configuration.
» Load Side 1 of the Tutoria Board.
»  When you create the Workpiece, define the Workpiece Alignment.
»  Choose No Fiducials.
2. Click on Dispensing Elements on the Program Commands toolbar.
» A Teach Window opens.
3. Click on Weight Control Lines.
» Notice, asshown in Figure 83, that the Teach Window has additional text
boxes below the video display specificdly for weight contral lines.
Enter weight, then teach point 1... E E . -
| = | T5TS
HEID Arc Circle
=
(€]
Cancel Areafill | Spiral fill
Position: @ %II
% GO it et lines| ik |
Y 5510 &
Z 0.000 Find sub Ht| Fattern
Brightness: a g
E a9 SeEct wal | Multipass
Customized Fons r— K »]
Dialogs for [Detete | L]
Weight-control
S ii Lti_ne Line Style: ’1—|E|
peCI cation Total Weight: ’E!— mg _|_

4.

Figure 8-3

Type 20 mg in the Total Weight text box.

»  Entering 20 mg means that 20 mg of fluid will be dispensed adong the length of

the line you will now define.

Beginning Programming
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10.

11.

13.
14.
15.
16.

17.
18.
19.

20.
21

23.

Move the camera crosshairs to the beginning of the top weight control line on Side
1 of the Tutorid Board.

Click on Teach.
Move the camera crosshairs to the end of the line.
Click on Teach.
Click on Done.

» A message box opens, indicating the calculated line speed for the newly
created weight control line.

Click on OK.
»  The Workpiece Pattern program should look like this:

Weight of Line

1 WEIGHT CONTROL: 20.000, 1,...

2 END \_ Line Style

Repeat Steps 2, 3 and 4, and type in 25 mg for the next weight control line.

Move the camera crosshairs to the beginning of the next weight control line on the
Tutorid Board.

Click on Teach.
Move the camera crosshairs to the end of the line.
Click on Teach.
Click on Done.

» A message box opens, indicating the calculated line speed for the newly
created weight control line.

Click on 0K.
Repeat Steps 2, 3 and 4, and type in 35 mg for the next weight control line.

Move the camera crosshairs to the beginning of the last weight control line on the
Tutorid Board.

Click on Teach.
Move the camera crosshairs to the end of the line.
Click on Teach.
Click on Done.

» A message box opens, indicating the calculated line speed for the newly
created weight control line.
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24. Click on OK.

25. Inthe Programming Window, select Edit Line Parameters from the Edit menu to
open the Line Parameters dialog box.

26. Set the Line Parameters for Line Type 1 to:
Pre-Move Delay Factor: 0.1

Shut-off Distance: 0.010
Dispense Gap: 0.015
Speed: (not used for weight control lines)
Dwdll: 0.0
Retract Distance: 0.100
Backtrack Gap: 0.050
Backtrack Length: 0.040
Backtrack Speed: 2
Down Speed: 2
Down Acceleration: 300
Retract Speed: 2
Retract Acceleration: 300
Suckback: 0.000

27. Click on Save.
28. Inthe Programming Window, select Dry Run from the Run menu.

»  Watch to see the camera transverse the programmed lines. Y ou may observe
adifference in dispensing speed for each line.

F'}‘\K The dispensing head will move after your response.

@ If you get an error message that the speed istoo slow, re-check your line
parameters and try again. Refer to Editing Lines earlier in this chapter.

29. Inthe Programming Window, select Wet Run from the Run menu.
»  Watch asthe lines are dispensed.
»  Examine the board for quality and accuracy.

This concludes the tutorial on Weight Control Lines.
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Dots

FMW can dispense precision dots as well as lines. Dots are used in surface mount adhesive
(SMA) applications. For this exercise, use the vave conditioning fluid. The conditioning fluid
simulates the characteristics of SMA fluids.

The size of the dots and characteristics of the dispensing are controlled by Dot Parametersin
the Edit Dot Parameters.

Y ou will learn how to program and dispense dots on the workpiece. Next, you will learn how
to dter the size of the dots and re-perform the dispense.

Estimated time to complete: 30 minutes.

To view the customizable parameters for Dot Parameters:

1. Inthe FMW Main Window, click on Teach a Program.

2. Inthe Programming Window, click on Edit and select Edit Dot Parameters.
» A didog box opensindicating the type of vave ingtaled on your dispensing
system and which valve, Valve 1 or Vave 2, is currently active.
3. Click on 0K,
» The Dot Parameters dialog box opens.
» Usethe horizontal scroll bar to see dl the columns,
» Below are brief explanations of the parameters.

Valve-On Time

Dwell

This parameter controls the time the valve is on while positioned over the dispensing location.
Thetime interva affects dot size. The longer the Valve-On Time, the larger the dot. The
units are in seconds. The typical value is 30 ms. However, the Valve-On time can be as long
as 6 seconds, depending on the desired dot size and fluid properties.

The Dwell is how long the dispensing head stays at the final position of a move before
retracting. This gives the fluid a chance to attach to the substrate. Increasing the Dwell can
reduce “stringing” of material. The units are seconds. For most solder pastes and adhesives,
30 msis sufficient. However, the Dwell can also be set aslong as 6 seconds for very elastic
fluids.

Dispense Gap

The Dispense Gap is the distance between the substrate you are dispensing on and the needle
tip during dispensing. This distance is one of the more common adjustments to optimize
dispensing programs. The units are in inches. Typicaly, the Dispense Gap is st to half the
dot diameter.
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Mid-Move 1 and Mid-Move 2

These parameters are advanced dot parameters used for specia applications and testing. For
more information, contact Asymtek Application Engineering.

Down Speed

The Down Speed is how fast the dispensing head lowers to dispense. Low viscosity fluids
tend to drip and you may want to set this parameter to a high value. The higher the vaue, the
faster the dispensing head will move. Height sense accuracy is dependent on Down Speed
and Down Acceleration. See more information on Height Sensor in the dispensing system
Operations Manua. The units are inches/second. Typically, 2 in/sec is the default setting.

Down Acceleration

This parameter controls how fast the dispensing head accel erates to the Down Speed. The
higher the value, the faster the dispensing head will move. The units are in inches/second
squared. Typically, 300 in/sec? is the defaullt setting.

Settling Time

Thisis the length of time that the dispensing head will park over the dispensing location
before beginning to dispense. The Settling Time is set to O, except in specia circumstances.
For more information, contact Asymtek Application Engineering.

On Vector Mode/Off Vector Mode

These parameters are advanced dot parameters used for special applications and testing. For
more information, contact Asymtek Application Engineering.

Number of Shots

This parameter controls how many shots of fluid will be dispensed at a single location. When
making larger dots, it is desirable to move the needle up between shots at the same location.
This parameter is set >1 for more than one dot at the same location, and the Multi-shot Delta
isthe vertical retract distance of the needle between each shot. The units are in shots.
Typicaly, thisis set to 1 unless you are dispensing as described above.

Multi-Shot Delta

Thisisthe height that the dispensing head retracts between multiple shots at the same
location. It is used in conjunction with Number of Shots. The units are in inches. If using with
Number of Shots, atypica valueis 0.010 inches.

Retract Speed

This isthe speed of the dispensing head while moving the Retract Distance. This parameter
effects when the dispensing head moves to do the next line. The units are in inches/second.
Typicdly, 2 infsec is sufficient.
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Retract Acceleration

Thisis the parameter that controls how fast the dispensing head comes up to the Retract
Speed. Y ou may need to set this high for smal dispensing moves. The units are
inches/second squared. Typically, 300 in/sec? is sufficient.

Retract Distance

Thisisavertical distance that the dispensing head moves after dispensing. The Retract
Distance must be within the Safe-Z Height defined in Initial Setup. The Retract Distance can
be reduced to increase dispensing speed. However, the dot quality will be affected in viscous
fluids. The units are inches. Typicaly, 100 mils (0.1 in) is sufficient.

Suckback

At the end of dispensing aline or adot, the valve is reversed for the Suckback period to
remove any material from the tip of the needle. The Suckback value should be set according
to fluid viscosity. Generdly, 10 ms (0.010 sec) is sufficient.

PostDwell

The amount of dwell time in seconds that the Z-head remainsin the XY position after the
Z-head retracts in the Z-axis (see the description of the Dwell parameter above). This
parameter is available for use in ZFast mode only and should be used for fluids with a
tendency to string. When used, the total dwell time is the sum of both parameters.

4. Click on 0K to close the Edit Dot Parameters dialog box and return to the
Programming Window.
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To program dots:

1

10.

11

Perform the Programming Setup in Chapter 6 - Setup and Configuration.
» Load Side 1 of the Tutorial Board.

»  When you create the Workpiece, define the Workpiece Alignment.
»  Choose No Fiducids.

Click on Dispensing Elements from the Program Commands toolbar.

Select Dot from the Dispensing Elements tool bar.

Use the Position Controls to move the crosshairs to the center of the dot in the
ULHC of the first Dots Square on the Tutoria Board.

Click on Teach.

Use the Position Controls to move the crosshairs to the center of the dot in the
URHC of the first Dots Square on the Tutorial Board.

Click on Teach.

Use the Position Controls to move the crosshairs to the center of the dot in the
center of the first Dots Square on the Tutorial Board.

Click on Teach.

For the remaining 2 dots in the square, choose Type 2 in the Dot Style text box in
the area below the video display, then teach the location of the two dots in the
LRHC and LLHC of the first Dots Square on the Tutorial Board.

Click on Done when you have defined each dot.
» Your program should look like this (your numbers may vary):

X,Y coordinates
e of the dot on the
workpiece

1 DOT: 1, (10.704, 10.064)
2 DOT: 1, (10, 691, 9.301)
3 DOT: 1, (11.439, 9.296)
4 DOT: 2, (11.449, 10.059)
5 DOT: 2, (11.449, 11.224)
END

Dot Style
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12. Sdlect Edit Dot Parameters from the Edit menu.

13. For an gpproximate 30 mil dot, set the Dot Parameters for Type 1 to:

14.
15.

16.
17.

18.

This concludes the tutorial on Dots.

Vave-On Time:
Dwell Time:
Dispense Gap:
Down Speed:
Down Acceleration:
Settling Time:
Number of Shots:
Retract Speed:
Retract Acceleration:
Retract Distance:
Suckback:
PostDwell

0.070 sec
0.030 sec
0015in
2in/sec
300 in/sec?
0

1

3in/sec
300 in/sec?
0.250in
0.000

0.00

Move the cursor to Type 2 in the Dot Parameters dialog box.

Set the Dot Parameter Vave-On Time to 0.250 sec, and Dwell Time to 0.050 sec.
Set dl the other parameters Type 2 to the same settings established for Type 1.

»  Thiswill adjust the Vave-On Time and Dwell for Type 2 dots.

Click on Save.

SelectDry Run from the Run menu.

»  Waitch to see the camera |locate the position of the dots.

r/‘\\ The dispensing head will move after your response.

Select Wet Run from the Run menu.
»  Watch to see the dots dispensed.

»  Examine the board, you should notice a difference in the size of the Type 1

and Type 2 dots.
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ZFast Mode

ZFast is an option that alows fluid to begin flowing through the pump as soon as the
dispensing head begins moving to the dispensing location within the Z-axis. Once the
dispensing head reaches the dispense height, the pump remains on until the dot is completed.
This feature is applicable only to dots and is not functional in Height Sense Always mode.

To activate the ZFast mode:

1. Inthe Programming window, place the cursor on the command before which the
ZFast command should appear.
2.  Select Set ZFast Mode from the Program menu.
» A drop-down menu apears, offering you the selections of ZFast ON or ZFast
OFF.
3. From the drop-down menu, select ZFast ON.

» The ZFast ingtruction has been placed into the program. Y ou can now edit the
ZFast gtatus from within the program by double-clicking on the ZFast
command.
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Arcs

There are two available methods for teaching an arc, Start, Middle, End (SME) and Center.

Refer to Figure 8-4 below.

The SME method asks you to teach a starting point for your arc, a middle point, and an end
point. The three points are treated like a part of a circle and the arc will be dispensed along

the three points accordingly.

The Center method asks you to teach a starting point on the arc followed by a center point.

Since the arc is treated like a part of acircle, the center point is the center of the circle if the
arc were to complete 360 degrees. Activating the Clockwise feature determines the direction
the dispensing head moves while dispensing.

The Degrees text box can be used with the Center method if you know how many degrees of
acomplete circle the arc will travel. However, the degrees are automatically calculated when
programming with the SME method.

The Line Style text box alows you to choose the line style for your arc. Clicking on Edit takes
you to the Edit Line Parameters dialog box for tailoring the line style. Weight Control lines

can also be used for arcs.

Estimated time to complete: 30 minutes.

Teach starting arc point...

Asymtek FmNT - Teach Window

St |0.000 | [0.000 | [|Ggta| @ Arc [S.M.E) method
widde: [0000  [0.000  [Goto] (! Arc [Center) method
End: [0.000 | [0.000 M

Center | | I_/

Degrees: 100 [N [ Weight Control
Line Style;“!"’e‘ B \il Weight: o. | T

each

(s

LCancel

Position:

X 14934
Y 9.506

z

0.000

Lighting:

HISE

. —
Dot Line
Arg Circle
Rectangle | Fotting
Areafill | Spival Il
&2 @
bl lines |k ctlFll
&
~a
Find sub He|  Fattern
ﬂ =
~a
Select val | Multipass

Figure 8-4
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To program arcs.

1. Peform the Programming Setup in Chapter 6 - Setup and Configuration.
» Load Side 1 of the Tutorial Board.
»  When you create the Workpiece, define the Workpiece Alignment.
»  Choose No Fiducids.
Click on Dispensing Elements from the Program Commands toolbar.
Click on Arc on the Dispensing Elements toolbar.
Select the method (SME or Center) for teaching the arc.
Use the Position Controls to move the dispensing head to the arc start point.
Click on Teach.

Do one of the following:

N o o bk~ w N

»  If usng the SME method, use the Position Controls to move the dispensing
head to the arc middle point.

»  If using the Center method, use the Position Controls to move the dispensing
head to the center of the arc.

,@5 NOTE Remember, if using the Center method, the center of the arc is

actualy the center of the circle that the arc is a part of. Also, you
need to fill in the Degrees value. This value is the number of
degrees of a complete circle that the arc will complete.

8. Click on Teach.
» If using the Center method, your arc is complete. Go to Step 12.
9. Usethe Position Controls to move the dispensing head to the arc end point.
10. Click on Teach.
11. Click on Done.
12. In the Programming Window, selectDry Run from the Run menu.

»  Watch to see the cameratrace the path of the arc.
f'!‘\\ The dispensing head will move after your response.

13. Select Wet Run from the Run menu.
»  Watch asthe arc is dispensed.
»  Examine the board for quaity and accuracy.

This concludes the tutorial on Arcs.
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Circles

There are two available methods for teaching a circle, Start, Middle, End (SME) and Center.

The SME method asks you to teach a starting point for your circle, amiddie point, and an end
point. The three points are treated like points aong the circumference of the circle and the
circle will be dispensed aong the three points accordingly. The Start and End points may be
the same point, but it is not necessary to program the circle in that manner.

The Center method asks you to teach a starting point on the circle followed by a center point.
This method may be difficult to use if you can not accurately determine the center of your
circle. The Degrees text box will automatically calculate the 360 degrees necessary to
complete the circle. Activating the Clockwise feature determines the direction the dispensing
head moves while dispensing.

The Line Style text box alows you to choose the line style for your circle. Clicking on Edit
takes you to the Edit Line Parameters dialog box for tailoring the line style. Weight Control
lines can also be used for circles.

Estimated time to complete: 30 minutes.

To program circles:

1. Perform the Programming Setup in Chapter 6 - Setup and Configuration.
» Load Side 1 of the Tutorial Board.
»  When you create the Workpiece, define the Workpiece Alignment.
»  Choose No Fiduciads.
Click on Dispensing Elements from the Program Commands tool bar.
Click on Circle on the Dispensing Elements toolbar.
Select the method (SME or Center) for teaching the circle.
Use the Position Controls to move the dispensing head to the circle start point.
Click on Teach.

Do one of the following:

N o o b~ wN

» If usng the SME method, use the Position Controls to move the dispensing
head to the second point on the circle.

» If using the Center method, use the Position Controls to move the dispensing
head to the center of the circle.

8. Click on Teach.
» If using the Center method, your circle is complete. Go to Step 12.
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9. Usethe Position Controls to move the dispensing head to the circle end point.
10. Click on Teach.

11. Click on Done.

12. In the Programming Window, selectDry Run from the Run menu.

»  Watch to see the camera trace the path of the circle.
F'}‘\K The dispensing head will move after your response.

13. Select Wet Run from the Run menu.
» Watch asthe circle is dispensed.
»  Examine the board for quaity and accuracy.

This concludes the tutorial on Arcs.
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Area Fill Encapsulation

Area Fill dispensing is used to encapsulate a part on a board. It is important for the fluid to
cover the part completely without voids. The process by which the fluid is dispensed should
be fine-tuned for best resuilts.

AreaFills can aso be dispensed using Weight Control. In that case, a defined weight of fluid
is dispensed in the Area Fill. If Weight Control is not used, the Line Parameters for the
selected Line Type are used.

In this exercise you will learn how to program and dispense asmple Area Fill.

,@5 NOTE If you are performing this tutoria during a new programming session, be sure

to review Chapter 1 - Getting Started and Chapter 6 - Setup and
Configuration.

Estimated time to complete: 30 minutes.

To program and dispense an Area Fill:

1. Perform the Programming Setup in Chapter 6 - Setup and Configuration.
» Load Side 1 of the Tutorial Board.
»  When you create the Workpiece, define the Workpiece Alignment.
» Choose No Fiducias.
2. Click on Dispensing Elements from the Program Commands toolbar.
Select Area Fill from the Dispensing Element Toolbar.
In the Teach Window as shown in Figure 85, type 0.1 in the Spacing text box.

» The spacing isin inches and represents the spacing between each line as
shown in Figure 8-6.

5. Usethe Position Controls to move the crosshairs to the outer end of the rectangular
spird on the Tutorial Board.

»  Thiswill be Corner 1.
Click on Teach.

Use the Position Controls to move the crosshairs to the diagonally opposite corner
of the rectangular spiral on the Tutorial Board.

»  Thiswill be Corner 2.
8. Click on Teach.
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9. Click on Done.
10. Select Dry Run from the Run menu.

»  Watch to see the camera move across the rectangular pattern.

.fj\ The dispensing head will move after your response.

@ If you get an error message that the speed is too slow, re-check your dot
parameters and try again.
11. Select Wet Run from the Run menu.
»  Waitch asthe Area Fill dispenses.
»  Examine the board for quaity and accuracy.
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Figure 8-6

This concludes the tutorial on Area Fill.
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Placing Patterns

Patterns, as explained in “Building a Program” earlier in this chapter, are essential building
blocks of complex dispensing processes for workpieces. In this exercise you will learn how to
create a ssimple dispensing pattern and place it on aworkpiece at multiple locations.

For this exercise, you will create a smple L-shaped underfill pattern and place it on the
workpiece Tutorial Board. Y ou will perform awet dispense.

g NOTE If you are performing this tutorial during a new programming session, review
Chapter 1 - Getting Started and Chapter 6 - Setup and Configuration.

Estimated time to complete: 45 minutes.

To program and place a pattern:

1. Perform aProgramming Setup.
» Load Side 1 of the Tutorial Board.
»  When you create the Workpiece, define the Workpiece Alignment.
»  Choose Two Fiducias.
2. From the Program Commands toolbar, click on Pattern, and select Create Pattern.
» Thedidog box in Figure 87 opens.

= Create Pattern

New Pattern Name: I

rFiducials

C/Hone (' DOne @ Two

“Skip Mark
[™ Use Pattern Skip Mark

oK Cancel Help

Figure 8-7

3. Typein FCLi nel inthe text box.
4. SelectTwo fiducids.

»  Skip Marks are basically specidized fiducias and will be explained later in
Chapter 9 — Advanced Programming.
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10.
11

13.

14.
15.

16.

17.

Click on OK.
» A Teach Window opens asking you to teach the pattern origin.

Use the Position Controls to center the camera crosshairs on the ULHC of Flip
Chip 1 on the Tutoria Board.

»  Thiswill bethe Origin of the pattern.
Click on Teach.
Click on Done.

»  The Teach Window changes asking you to select amethod for defining a
fiducid.

Select Corner Finder and click on Next.

»  Thedispensing head should till be centered on the ULHC of Flip Chip 1,
where you taught the pattern Origin. If it is not, use the Position Controls to
move it there.

»  Notice the Quadrant Model, the green square in the area below the video
display. The ULHC of the Quadrant should be highlighted to indicate that this
is the corner you are going to teach. If the ULHC is not highlighted, click on it
to highlight it.

Click on Teach.
Test the fiducial for accuracy, or click on Next to continue.

»  The Teach Window changes and you are asked to select a method for
defining the second fiducial.

Select Corner Finder and click on Next.
Use the Position Controls to center the crosshairs on the LRHC of Flip Chip 1.
»  Thiswill be the second fiducid.

» The ULHC of the Quadrant Model should be highlighted to indicate that thisis
the corner you are going to teach. Click on it to highlight it.

Click on Teach.
Test the fiducial for accuracy, or click on Next to continue.

»  The Teach Window closes and a message box opens indicating that the
dispensing head is “ About to move to Reference Origin of Workpiece.”

Click on OK.

/?-\ The dispensing head will move after your response.

In the Programming Window, select FCLi nel in the Pattern Name text box.

» A message box opens indicating that the dispensing head is “About to move to
Reference Origin of FCLinel.”
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18.

19.

20.
21

23.
24.
25.
26.
27.
28.
20.

3L

32.

S

Click on 0K.

/‘\\ The dispensing head will move after your response.

Select Edit Line Parameters from the Edit menu and check to make sure that the
Line Parameters for Style 1 match those values established earlier in the tutorial for
Weight Control lines.

Click on Dispensing Elements in the Program Commands toolbar.

Click on Weight-Control Line.

Enter 20 mg in the weight text box and choose Style 1.

Use the Position Controls to center the crosshairs on the ULHC of Flip Chip 1.
Click on Teach.

Use the Position Controls to center the crosshairs on the URHC of Fip Chip 1.
Click on Teach.

Use the Position Controls to center the crosshairs on the LRHC of Fip Chip 1.
Click on Teach.

Click on Done.

» A message box opens, indicating the calculated line speed for the newly
created weight control line.

Click on OK.
» You have defined an L-shaped line around Flip Chip 1.
» Your FCLi nel program should look like this:

1 WEIGHT CONTROL: 20.000, 1, ...
2 END

In the Programming Window, select “Workpiece” from the Pattern Name text box.

» A message box opensindicating that the dispensing head is “ About to move to
Reference Origin of Workpiece.”

Click on 0OK.
Click on Dispensing Elements from the Program Commands toolbar.
Click on Pattern on the Dispensing Elements tool bar.

In the Available Patterns text box in the lower portion of the Teach window, select
FCLi nel.

Use the Position Controls to center the camera crosshairs on the ULHC of Flip
Chip 1.
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»  Thiswill be where you will place your pattern.
37. Click on Teach.

38. Usethe Position Controls to center the camera crosshairs on the ULHC of the
adjacent Hip Chip 2.

»  The pattern will adso be placed at this location.
39. Click on Teach.
40. Click on Done.

» Your program should look like this:

Function call to
dispense the line
FCLinel at this
- X,y location
1 DO: FCLinel at (0.348, 0.429)
2 DO: FCLine at (0.546, 0.356)
3 END

» Your location numbers may vary from this example.

41. Select Dry Run from the Run menu.
»  Watch to make sure that the program goes through the following steps:

Locate Fiducials 1 (ULHC) and 2 (LRHC) of the Workpiece.
Locate Fid 1 (ULHC) of Flip Chip 1.

Locate Fid 2 (LRHC) of Flip Chip 1.

Locate Fid 1 (ULHC) of Hip Chip 2.

Locate Fid 2 (LRHC) of Fip Chip 2.

Dry dispense L-shaped line starting at Fid 1 on Hip Chip 1.

Dry dispense L-shaped line starting at Fid 1 on Hip Chip 2.

42. Select Wet Run from the Run menu.
»  Watch as the pattern is dispensed in both locations.
»  Examine the board for quaity and accuracy.

This concludes the tutorial on Placing Patterns.
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9 Advanced Programming

Overview

This chapter discusses and demonstrates some of the more advanced techniques for
perfecting your dispensing programs. Y ou will perform two underfill tutorias, one L-shaped
pattern and one U-shaped pattern. Y ou will learn how to increase throughput by using timers
and skip marks and reusing fiducias and height sense information.

,@ NOTE Y ou should complete the preceding chapter, “Beginning Programming”
before attempting the tutorials in this chapter.

Programming Tips

Below are several commonly used programming conventions that should help you perfect
your dispensing programs.

Order of Pattern Placement and Timers

The order that the patterns are dispensed is an important part of optimizing the whole
workpiece program.

For instance, in a U-shaped pattern, as shown in Figure 9-2, the first underfill line is dispensed
at all pattern locations on the workpiece. Then, the second underfill line is dispensed at dl
pattern locations. Findly, the U-shaped seal passis dispensed at al pattern locations. Timers
are set for each of these steps using the Reset Multipass Timer and Await Multipass Timer
commands in the Program Commands Toolbar. This technique is demonstrated in the
exercisesin this chapter.
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Re-using Fiducials and Height Sense Information

If your workpiece contains many parts, and the pattern to be dispensed is atwo or three part
pattern such as the L-shaped and U-shaped patterns, checking fiducias and the substrate
height during every pass can be time consuming. In many cases, it is unnecessary since the
likelihood that the parts could move before the timers expire is very low. Rather than finding
fiducias and doing a Height Sense check during every pass, fiducials and Height Sense
checks are performed once for each part and the information is stored and reused during the
second pass. Thisis called “Re-using Fiducias’ and is enabled by selecting “Pass Block”
from the Pattern button on the Program Commands toolbar. This feature is a significant time-
saving option.

Fiducial Options

In Setup Vision on the Configuration menu, there is a Vison Parameter caled “Fiducia
Options’ with the choices “ Pause after search,” “Skip” and “Prompt”. Activating “Pause
after search” means that FMW will pause after every fiducial search and display a message
box indicating the status of the fiducial. This can be helpful during programming sessions, but
is not recommended for production runs since it requires an operator response in order to
continue. When developing a dispensing program, pausing after afiducia search to verify that
the correct fiducial was found is a good way to determine the best fiducia to use for an
goplication.

“Skip” and “Prompt” can be used for production runs. Occasionally chips are placed skewed
on aworkpiece or a defect interferes with afiducial. In this case, if “ Skip” is chosen, the
program will automaticaly skip the fiducia or part it is searching for and continue with the
next step in the program. If “Prompt” is selected, the Operator is asked to either re-teach the
unfound location, or skip it and continue the run.

Skip Mark Options

When you create a pattern in FMW, there is an option caled “ Skip Marks’ that can be
activated and used for the new pattern. Skip marks are specialized fiducials that can greatly
increase throughput in applications that require the same pattern to be placed in multiple
locations on one board. For example, if Workpiece has the same L-fill pattern dispensed at
multiple locations, and there is a possibility that some of those locations may need to be
skipped, both Workpiece and L-fill can have skip marks to indicate status. When the program
executes, the Workpiece skip mark can be used to indicate if the entire board is good or not.
Depending on how the skip mark is used, if the Workpiece skip mark is not found, the L-fill
skip marks will be checked, and any L-fill pattern whose skip mark could not be found will be

skipped.
Weight Control on Multiple Passes

Weight control lines are usualy used for dl linesin multiple pass programs. Different line
styles are sometimes defined for each line of the program. For instance, the first L-shaped
line in an L-shaped pattern usualy is defined with a higher weight than the second L -shaped
“sedl pass’. This assumes that the fluid will flow undernesth the die to the opposite corner.
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Chip Offset

Chip Offset is the distance between the edge of the part (usually adie) and the edge of the
dispensing needle. It is defined to ensure that the needle does not chip the die edge during a
dispense. The Chip Offset is used in the X-axisand Y-axis as shown in Figure 9-1. A formula
is used to calculate the Chip Offset:

g, + 7 mil = Chip Offset

where d, isthe outer diameter of the needle.

Reticles can aso be used to perform the same function as Chip Offset. Using reticles while
programming can often be easier and quicker to use than the Chip Offset formula. Refer to
“Vison System Setup” in Chapter 6 — Setup and Configuration for reticle setup instructions.

Needle Tip

Chip offset

Perimeter
1/2 Needle
Diameter + 7 mils
from Cornerin X
and Y -axis

Chi

Figure 9-1
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Underfill Patterns

There are severd types of line patterns used for underfill applications. Two common types
are L-shaped and U-shaped patterns as shown in Figure 9-2. Variations of these types of
underfill patterns are used as well. These patterns and processes are designed to assure
complete underfilling without excess and to prevent voids in the underfill.

First Pass Underfill Passes

N /

———
I — 1
__ U-shaped
Seal Pass

L-shaped Pattern U-shaped Pattern

Seal Pass

Figure 9-2
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Advanced Underfill Workpiece

In these exercises, you will learn to program an entire underfill workpiece. The first exercise
will be the L-shaped pattern. The second exercise will be the U-shaped multipass pattern.
You will learn when to insert timer commands, height sense commands, flow rate
measurements, use skip marks and re-use fiducials.

Estimated time to complete: 60 minutes

For the exercise below, you will use Side 2 of the Tutorial Board. You are building a
dispensing program to dispense an L-shaped underfill line on four flip chip models on the
workpiece. On a second pass, the program will dispense another L-shaped “sedl” passline
aong the opposite edge over the same flip chip modds. To do this, you will perform the
following:

Define the Tutorial Board Side 2 as the Workpiece with 2 fiducials in the opposite
corners and a skip mark.

Create an L-shaped pattern called “Lf i | | ” which will consist of the two L-shaped
lines, Lineland Line 2.

Definethe originof Lfi | | .

Define fiduciasfor Lfi | | .

Define askip mark for Lfi | I .

Teach thefirst L-shaped, Linel, in Lfill.

Teach the second L-shaped, Line2,inLfill.

Place the pattern Lf i | | on the workpiece at three locations.
Savetheprogramas undrfil . f mw

Perform adry run.

Perform awet run.

g NOTE If you are performing this tutorial during a new programming session, be sure

to review Chapter 1 - Getting Started and Chapter 6 - Setup and
Configuration.

For the following exercise, you will need to use an underfill epoxy, such as Hysol 4510 and a
#20 gauge 1/4 inch needle.

Advanced Programming 9-5



To program the workpiece with L-shaped underfill patterns:

1

© N o g B~ W DN

10.
11

13.
14.

15.
16.

17.
18.

Perform a Programming Setup. (See Chapter 6 - Setup and Configuration for
assistance.)

» Load the Tutoria Board to Side 2 with the multiple underfill patterns.

»  For Setup Workpiece Alignment, choose Two Fiducials, and Learn Workpiece
Angle first.

»  For your fiducias, use the Modd Finder method and program Fid 1 as the
fiduciad inthe LLHC and Fid 2 as the fiducid in the URHC on Side 2 of the
Tutoria Board.

In the FMW Main Window, click on Teach a Program.

Click on Pattern on the Program Commands tool bar.

Select Create Pattern.

TypeLfil | inthetext box.

Select One fiducid.

Activate the Use Pattern Skip Mark feature.

Click on OK.

» A Teach Window opens asking you to teach the pattern origin.

Use the Position Controls to center the camera crosshairs on the ULHC of the flip
chip in the ULHC of Pettern 1 on Side 2 of the Tutorial Board.

» Teach the Origin exactly at the corner of the flip chip modd. Y ou do not use
the Chip Offset until you are programming the lines.

Click on Teach.

Click on Done.

» You are now asked to select a method for teaching the fiducial.
Select Corner Finder.

Click on Next.

Teach Fid 1 of thepattern Lf i | | at the same location as the Origin.

» Make sure that the ULHC of the Quadrant Model in the area below the video
display is highlighted. If it isnot, click oniit to highlight it.

Click on Teach.

Test Fid 1 or click on Next.

»  The Teach Window closes and the Edit Pattern Skip Info dialog box opens.
Select Skip Pattern If Mark Not Found.

Click on Teach Skip Mark.
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19.

21

23.

24.

25.

26.

27.

28.

3L

» A Teach Window opens asking you to select the method for teaching your
skip mark.

Select Model Finder.
Click on Next.

Use the Position Controls to center the camera crosshairs on the dot dightly above
and to the left of where you taught the origin and fiducial.

Click on Teach.
Test the skip mark or click on Next.

» The Teach Window closes and you return to the Edit Pattern Skip Info dialog
box.

Click on 0K to close the box.
» A message box opens indicating that the dispensing head is about to move to
the “Workpiece’ origin.

f"\ The dispensing head will move after your response.

Click on OK.

» Thedispensing head moves to the origin of Workpiece.

Select Lfi | | from the Pattern Name text box.

» A message box opensindicating that the dispensing head is about to move to
the “Lfill” origin.

f{'\ The dispensing head will move after your response.

Click on OK.

»  Thedispensing head movesto the origin of Lfill.
From the Program Commands toolbar, click on Pattem.
Select Pass Block.

» The Start Pass instruction dialog box opens.

»  Thisisthe command that alows you to re-use the fiducia and height sense
information for each pass, rather than perform the operation each time.

Enter 2 inthe Number of passes text box.
Click on OK.

»  Notice the program lines:

1 START PASS: FOR PASS 1
2 END PASS:
3 START PASS: FOR PASS 2
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32.

&

37.

30.

41.

42.

47.

4 END PASS:
END

Place the cursor on the first END PASS.

From the Program Commands tool bar, click on Dispensing Elements.
» A Teach Window opens.

From the Dispensing Elements toolbar, click on Find Substrate Height.

Use the Position controls to move the dispensing head to alocation near the flip
chip moded!.

»  When you have actua parts placed on aworkpiece, you do not want to teach
the height of the parts, but rather the height of substrate onto which you will
dispense. That iswhy alocation near the flip chip model is chosen.

Click on Teach.

» Do not click on Done. You do not have to exit this Teach Window to continue.
From the Dispensing Elements toolbar, click on Weight-Control Lines.

Enter 50 mg in the Total Weight text box and select Line Style 1.

» Thisisthetota weight to be dispensed at dl locations where this pattern will
be placed.

Use the Position Controls to move the dispensing head to the ULHC of the first flip
chip in the ULHC of Pattern 1.

» UseChip Offset or reticles.
Click on Teach.

Use the Position Controls to move the dispensing head to the URHC of the same
flip chip.

» UseChip Offset or reticles.
Click on Teach.

Use the Position Controls to move the dispensing head to the LRHC of the same
flip chip.

»  UseChip Offset or reticles.

Click on Teach.

» Now you have to exit the Teach Window.

Click on Done.

» A message box opens indicating the caculated line speed.
Click on 0K.

From the Program Commands toolbar, click on Time and select Reset Multipass Timer.
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»  Thiswill gart the timer after the first line is dispensed.

48. Place the cursor on the second END PASS and click on Time in the Program
Commands tool bar.

49. Select Await Multipass Timer.
» The Await Multipass Timer instruction dialog box opens.

Advanced Programming
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IR
52.

g

57.

59.

61.

62.

Typein 30 seconds.
»  The system will wait for 30 seconds before beginning the next run.

»  Set the timer according to how long your fluid takes to underfill the flip chip
model.

Click on OK.

From the Program Commands toolbar, click on Dispensing Element.
Select Weight-Control Lines.

Enter 30 mg in the Total Weight text box and select Line Style 1.

Use the Position Controls to move the dispensing head to the ULHC of thefirst flip
chip in the ULHC of Pattern 1.

» UseChip Offset or reticles.
Click on Teach.

Use the Position Controls to move the dispensing head to the LLHC of the same
flip chip.

» UseChip Offset or reticles.
Click on Teach.

Use the Position Controls to move the dispensing head to the LRHC of the same
flip chip.

» UseChip Offset or reticles.

Click on Teach.

Click on Done.

» A message box opensindicating the calculated line speed.
Click on OK.
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63. From theFile menu, select Save andtypein undr fi | . f nwto save your program
asundrfil.fmw

»  Your program should look like this:

The program will
find a substrate . XY Locations
height at this XY 1 START PASS: FOR PASS 1 Defining Line 1

location ™~ 5 FIND SUBSTRATE HEIGHT: (X, Y)
3 WEIGHT CONTROL: 50.00, 1, (DX, Yil.DX. Yal.
ThisistheL-/ (Ba. wil.Dxe. yal
shaped line in X3, yz1)

the first pass

Line Style
4 RESET MULTIPASS TIMER:

5 END PASS:
This is the 6 START PASS: FOR PASS 2

command to wait

Weight of Line

until the 30 7 AWAIT MULTIPASS TIMER: 30 seconds(s)
second timer has /
going on to the
next command [xs, yaD) XY Locations
o] END PASS: Defining Line 2
10 END

64. Inthe Pattern Name text box, select Workpiece.
» A message box opensindicating that the dispensing head is about to move to
the “Workpiece” origin.

f{'\\ The dispensing head will move after your response.

65. Click on OK.

66. Place the cursor on END.

67. From the Program Commands toolbar, click on Process.
68. Select Measure Flow Rate.

69. To set up for placing the pattern Lfill, click on Pattem on the Program Commands
toolbar.

70. Select Loop Block.

71. Type 2 intheNumber of Passes text box for the two L-shaped passesin Lfi | | .
72. Click on OK.

73. Inthe programming screen, place the cursor on Next Loop.

74. Click on Pattern on the Program Commands toolbar.

75. Select Place Multipass Pattern.
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76.

78.
79.

8l
82.

87.

89.

In the Teach Window, select Lf i | | intheAvailable Patterns text box.

Use the Position Controls to move the dispensing head to the ULHC of the first flip
chip in the ULHC of Pattern 1.

Click on Teach.
Click on Done.

»  You program will look like this:

MEASURE FLOW RATE
LOOP PASS: FROM 1 TO 2

DO MULTIPASS: LFill AT (x1, y1)
NEXT LOOP:

END:

ga A W N BB

Place the cursor on NEXT LOOP.

Click on Pattern on the Dispensing Process toolbar.

Select Place Multipass Pattern.

In the Teach Window, select Lf i | | intheAvailable Patterns text box.

Use the Position Controls to move the dispensing head to the ULHC of the first flip
chip in the ULHC of Pattern 3.

Click on Teach.

Use the Position Controls to move the dispensing head to the ULHC of thefirst flip
chip in the ULHC of Pattern 5.

Click on Teach.
Click on Done.

» Yourundrfil.fmwvprogram will look likethis:

MEASURE FLOW RATE

LOOP PASS: FROM 1 TO 2

DO MULTIPASS: Ifill AT (X1, Y1)
DO MULTIPASS: Ifill AT (X2, ¥2)
DO MULTIPASS: Ifill AT (Xs, Y3)
NEXT LOOP:

END:

0o N o b~ WN P

Click on Edit on the menu bar.

90. Select Edit Pattern Skip Info.
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9L

92.

R

97.

100.

101.
102.
103.
104.
105.
106.

107.
108.
100.
110.

»  The Edit Pattern Skip Info diaog box opens.
Select Check Children If Mark Not Found.

» Thismeansthat the if the Workpiece skip mark is not found, the Lfill skip
marks will be checked.

Click on Teach Skip Mark.

» A Teach Window opens asking you to select the method for teaching the skip
mark.

Select Model Finder.
Click on Next.

Use the Position Controls to center the camera crosshairs on the dot in the ULHC
of the Tutoria Board.

»  Thiswill be the Workpiece skip mark.
Click on Teach.
Test the skip mark or click on Next.

» The Teach Window closes and you return to the Edit Pattern Skip Info dialog
box.

Click on OK.
Unload the board.

Use apen tofill in or make an “X” over the dot in the ULHC of the Tutoria Board
Side 2, where you taught the Workpiece skip mark.

Fill in or make an “X” over the dot in the ULHC of Pettern 3.
Load the board.

Click on Main on the Process Toolbar to go to the Main Window.
In the Main Window, click on Configuration.

Select Setup Vision.

In the Fiducial Options section of the Vision Parameters dialog box, activate Pause
After Search and Prompt.

In the Skip Mark Options section, activate Pause After Search.
Click on OK.

In the Main Window, click on Teach a Program.

From the Run menu, select Dry Run.

»  Check to seeif al fiducials are found and that the program executes the lines
at the correct locations.

» Respond to any prompts after fiducial and skip mark searches.
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111. From the Run menu, select Wet Run.
»  Watch to make sure that the program, performs the following:

Finds two corner fiducias on the workpiece.

Finds the Workpiece skip mark.

Finds the fiducias at each flip chip modd location for the Lfi | | pattern.
- FindstheLfil | skip marks.

,Qf NOTE The skip mark for Pattern 3 should not be found and the
pattern should be skipped.

Performs a Flow Rate measurement. (Only performed on Wet Run.)
Performs a Substrate Height M easurement.
Dry dispenses L-shaped lines around each of the flip chip models.

Waits for the timer to expire, then dry dispenses L-shaped lines around the
opposite corners of the flip chip modds.

This concludes the tutorial on a L-shaped Underfill Pattern.

In the next exercise, you will learn how to program a U-shaped multipass program as shown
inError! Reference sour ce not found.. Skip marks will not be used.
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To program a U-shaped multipass.

1

a A~ WD

10.

11.

13.
14.
15.

16.
17.

Perform a Programming Setup. (See Chapter 6 - Setup and Configuration.)
» Load the Tutorid Board to Side 2 with the multiple underfill patterns.

»  For the Configure Workpiece, choose Two Fiducials, and Learn Workpiece Angle
first.

»  When prompted to Teach your fiducias, program Fid 1 asthe fiducid in the
ULHC and Fid 2 as the fiducid in the LRHC of Side 2 of the Tutorial Board.

From the Main Window, click on Teach a Program.

From the Program Commands toolbar, click on Pattem and select Create Pattern.
Type U- pass in the text box and select Two fiducias.

Click onOK.

» A Teach Window opens asking you to teach the pattern origin.

Use the Position Controls to center the camera crosshairs on the ULHC of the first
flip chip in the ULHC of Peattern 3 on Side 2 of the Tutoria Board.

»  Teach the Origin exactly at the corner of the first flip chip. You do not use the
Chip Offset formula until you are programming the lines.

Click on Teach.
Click on Done.

»  The Teach Window changes and you are asked to select a method for
teaching the first fiducid.

Select Corner Finder.

Click on Next.

» Teach Fiducid 1 at the same location as the Origin.

» Make sure that the ULHC of the Quadrant Modd is highlighted.
Click on Teach.

Test thefiducid of click on Next.

»  The Teach Window changes and you are asked to select a method for
teaching the second fiducid.

Select Corner Finder.
Click on Next.

Use the Position Controls to center the camera crosshairs on the LRHC of the
same flip chip modd.

» Make surethat the LRHC of the Quadrant Modd is highlighted.
Click on Teach.
Test the fiducia or click on Next.
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18.

19.
20.

21

23.

24.
25.
26.

27.

28.

Click on Done.
» A message box opensindicating that the dispensing head is about to move to
the “Workpiece’ origin.

A The dispensing head will move after your response.

Click on OK.

Select U- pass from the Pattern Name text box.

» A message box opens indicating that the dispensing head is about to move to
the “U-pass’ origin.

;’T\ The dispensing head will move after your response.

Click on 0OK.
From the Program Commands toolbar, click on Pattern and select Pass Block.

»  Thisisthe command that allows you to re-use the fiducial and height sense
information for each pass, rather than perform the operation each time.

Enter 3 intheNumber of passes text box and click on OK.

»  Notice the program lines:

START PASS: FOR PASS 1
END PASS:

START PASS: FOR PASS 2
END PASS:

START PASS: FOR PASS 3
END PASS:

END

N o o b~ WwON P

Place the cursor on the first END PASS.

Click on Process on the Program Commands toolbar.
Select Find Substrate Height.

» A Teach Window opens.

Use the Position Controls to move the dispensing head to a location near the flip
chip mode on the Tutorial Board.

» Do not teach this point over aflip chip, when you actually have a die attached
in real applications. Y ou want to teach the height of the substrate, not the parts
on the substrate.

Click on Teach.
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»  The program should look like this:

START PASS: FOR PASS 1

FIND SUBSTRATE HEIGHT: (X, Yy)
END PASS:

START PASS: FOR PASS 2

END PASS:

START PASS: FOR PASS 3

END PASS:

END

O N o 0o B~ W N P

29. From the Program Commands toolbar, click on Dispensing Elements.
30. Click onWeight Control Lines.
31. Enter 30 mg in the Total Weight text box and sdlect Line Style 1.

32. Usethe Position Controls to move the dispensing head to the ULHC of thefirst flip
chip model in Pettern 3

»  UseChip Offset or reticles.
Click on Teach.

34. Use the Position Controls to move the dispensing head to the URHC of the same
flip chip modd.

» UseChip Offset or reticles.
35. Click on Teach.
36. Click on Done.

&

37. From the Program Commands toolbar, click on Time.
38. Select Reset Multipass Timer.
»  Thiswill start anew timer for the second undefill line.

39. Placethe cursor on the second END PASS and click on Time in the Program
Commands tool bar.

Select Await Multipass Timer.

SRS

. Typein 20 seconds and click on 0K. .
. Placethe cursor on END PASS (for Pass 2).

S

From the Program Commands toolbar, click on Dispensing Elements.
Click onWeight Control Lines.
Enter 30 mg in the Total Weight text box and select Line Style 1.

Use the Position Controls to move the dispensing head to the ULHC of the first flip
chip modd in Pattern 3.

s & R B
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47.

49.

51
52.

&

57.

59.

61.

62.

R

»  UseChip Offset or reticles.
Click on Teach.

Use the Position Controls to move the dispensing head to the URHC of the same
flip chip modd.

» UseChip Offset or reticles.

Click on Teach.

Click on Done.

From the Program Commands toolbar, click on Time.
Select Reset Multipass Timer.

»  Thiswill start anew timer.

Place the cursor on the last END PASS (for Pass 3) and click on Time in the Program
Commands toolbar.

Select Await Multipass Timer.

Typein 20 seconds and click on OK.

From the Program Commands toolbar, click on Dispensing Elements.
Click onWeight Control Lines.

Enter 80 mg in the Total Weight text box and select Line Style 1.

» Thisisthetotal weight to be dispensed at al the locations where this pattern
will be dispensed. In this case, four U-shaped lines around the four flip chip
modelsin Pattern 3 on the Tutoria Board.

Use the Position Controls to move the dispensing head to the ULHC of thefirst flip
chip moded.

» UseChip Offset or reticles.
Click on Teach.

Use the Position Controls to move the dispensing head to the LLHC of the same
flip chip modd.

» UseChip Offset or reticles.
Click on Teach.

Use the Position Controls to move the dispensing head to the LRHC of the same
flip chip modd.

» UseChip Offset or reticles.
Click on Teach.

Use the Position Controls to move the dispensing head to the URHC of the same
flip chip modd.

» UseChip Offset or reticles.
Click on Teach.
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67.

Click onDone.

68. From theFile menu, select Save As and typein mul t i pas. f nwto savethefileas

69.

70.
71
72.
73.

74.

75.
76.

mul ti pas. f mw.

» Your program should look like this:

START PASS: FOR PASS 1

FIND SUBSTRATE HEIGHT:(X, Y)

WEIGHT CONTROL:30.00,1,([X1,Y:]1,[%2,Y>1)
RESET MULTIPASS TIMER:

END PASS:

START PASS: FOR PASS 2

AWAIT MULTIPASS TIMER: 20 seconds(s)
WEIGHT CONTROL:30.000,1, ([X1,Y:]1, %, Y-1)
RESET MULTIPASS TIMER:

END PASS:

START PASS: FOR PASS 3:

AWAIT MULTIPHASE TIMER: 20 second(s)

© 00 N oo o B~ W N B

L I
A W N B O

END PASS:
END:

=
(&)

WEIGHT CONTROL:80.000,1, (X1,Y1),(X2,Y2) » (X3,¥3) » (Xa,Ya)

In the Pattern Name text box, select Workpiece to return back to the Workpiece

program.

» A message box opensindicating that the dispensing head is about to move to

the “Workpiece” origin.
f{'\\ The dispensing head will move after your response.

Click on OK.

Place the cursor on END.

From the Program Commands toolbar, click on Process and select Measure Flow Rate.

To set up for placing the pattern U- passs, click on Pattem on the Program
Commands tool bar.

Select Loop Block and typein 3 for the three passes (U-shaped line and two seal

passes) in U- pass.

Place the cursor at Next Loop.

Click on Pattern on the Program Commands toolbar, and select Place Pattern.

Advanced Programming
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78.

79.

8L
82.

&

87.

In the Teach Window, select U- pass inthe Available Patterns text box.

Use the Position Controls to center the camera crosshairs on the ULHC of the first
flip chip model in Pattern 3 on the Tutorial Board workpiece.

Click on Teach.

Choose Done.

» Your program will look like this:

NEXT LOOP:
END:

o b~ W N P

MEASURE FLOW RATE
LOOP PASS: FROM 1 TO 3
DO MULTIPASS: U-pass AT (X1, Vi)

Place the cursor on NEXT LOOP.

Click on Pattern on the Program Commands toolbar, and select Place Pattern.
In the Teach Window, select U- pass inthe Available Patterns text box.

Use the Position Controls to center the camera crosshairs on the ULHC of the
second flip chip modd in Pattern 3 on the Tutoria Board workpiece.

Click on Teach.

Use the Position Controls to center the camera crosshairs on the ULHC of the
remaining two flip chip models in Pattern 3 on the workpiece.

Click on Done when you have finished teaching the last two flip chips.

»  You program will look like this:

NEXT LOOP:
END:

0o N o 0o b~ W N P

MEASURE FLOW RATE

LOOP PASS: FROM 1 TO 3
DO MULTIPASS:
DO MULTIPASS:
DO MULTIPASS:
DO MULTIPASS:

U-pass AT (X,
U-pass AT (X,
U-pass AT (Xs,
U-pass AT (X,

88. From the File menu, sdlect Save.

y1)
y2)
ys)
ys)
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89. From theRun menu, select Dry Run.

»  Make certain that the program executes the following steps correctly:

Finds two corner fiducias on the workpiece.

Finds the fiducids at each flip chip modd location for the U- pass
pattern.

Perform a Flow Rate measurement. (Only performed on Wet Run.)
Performs a substrate height measurement.
Dry dispenses two lines around each of the four flip chip models.

Waits for the timer to expire, then dry dispenses a single U-shaped line
around the four flip chip models.

90. When satisfied that the program executes correctly, select Wet Run from the Run

menu.

This concludes the tutorial on a U-shaped Multipass Wor kpiece.

Advanced Programming
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10 Running Production

After aprogram has been built and the dispensing process perfected, the program will be
used in a Production Run. This chapter will guide the Operator through a System Set-up,
Production Run and Shut Down.

The exercisesin this chapter assume that the dispensing system is in good working order as
described in System Setup and Operation in Chapter 3 - Tour of Fluidmove. Y ou will use the
TS-01 Interface Smulator, included as an accessory with your dispensing system, to smulate
SMEMA production conveyor activity for conveyor dispensing systems. In addition, the
exercises will use the program nul t i pas. f mwfrom Chapter 9 - Advanced Programming
during the production run.

This chapter does not contain specific instructions for interfacing production runs with other
systems or SECS/GEM interfaces. It isintended as a training guide for running production.
An operator guide for SECS/GEM interfacing is included in Chapter 4. Complete
programming reference information for the SECS/GEM interface is contained in the
SECS/GEM Interface Option for Fluidmove for Windows manud.

Estimated time to complete: 30 minutes.

To Start a Production Run

Production runs are executed from the Production Window. In this window, the operator
selects the program to be run, then performs a prompted setup routine. This routine is the
same prompted setup routine as described in Chapter 6- Setup and Configuration. After the
setup is complete, the production run is started.

Before the run begins, the Run Window opens. See Figure 10-1. In the Run Window, the
Operator has information on the run status, fluid status, error status and SECS/GEM status.
The Operator has full control of the run using on-screen controls in the Run Window. Also,
you can choose to perform a wet run, with dispensing, or adry run with no dispensing. The
conveyor can be disabled for dispense tests, and a set number of runs to be performed can
aso be indicated.
Follow the procedure below to begin a production run.
To begin a production run:

1. Inthe FMW Main Window, click on Run a Program.

2. Inthe Production Window, click on Setup.

3. Click on Prompted Setup.
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4. Follow the on-screen prompts.

5. Once you have completed a Prompted Setup, click on Load in the Production
Window.

6. Sdectmul ti pas. f mwfromthefilelist and click on OK.

» A didog box opensteling you that FMW is “Downloading
<filename>...please wait.”

7. After thefile has loaded, click on Run in the Production Window.

8. Click on Run Production.
»  The Run Window opens. See Figure 10-1.
» A message box appears requesting you to “Clear the conveyor”.

9. Clear the conveyor.
10. Click on OK.

11. Place a Tutoriad Board at the mouth of the conveyor.

12. Click on Go.
» Themessage “Waiting for a board” will appesr.
» TheTutorid Board will be conveyed into the dispensing area. Stop pins will

raise to stop the board at the Dispense Zone. Lifter tables or bar clamps will
clamp the part in place. Dispensing will be performed.
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Asymtek Fluidmove - Run Window

Figure 10-1
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To Simulate a Production Run

This exercise will teach you how to smulate a production run on conveyor dispensing

systems.

Follow the procedure below to smulate a production run.

To simulate a production run:

1. Unload dl boards.

2. Turnthe Man Power Switch OFF.

3.  Ingdl the TS-01 asindicated below:

a
b.

Attach the TS-01 Upstream/Downstream cable adapter to the TS-01 box.

Attach the TS-01 Upstream Cable to the upstream connector on the Interface
Module at the rear of the dispensing system. Refer to the dispensing system
Operations Manua for help locating the module if necessary.

Attach the TS-01 Downstream Cable to the downstream connector on the
Interface Module at the rear of the dispensing system. Refer to the dispensing
system Operations Manud for help locating the module if necessary.

Make sure that al of the I« O/INDEP switches along the edge of the TS-01
box are all set to INDEP.

Make sure that DRIVERS/OPTO 1/O switch in the corner of the TS-01 box is
set to OPTO I/0.

4, Turn the Main Power Switch ON.

5. Inthe FMW Main Window, click on Run a Program.

6. Inthe Production Window, click on Load.

7. Sdectnul tipas. f mwfrom thefilelist and click on OK.

>

A didog box openstdling you that FMW is “Downloading
<filename>...please wait.”

8.  Click on Setup.

9. Click on Prompted Setup.

10. Follow the on-screen prompits.

11. Click on Run in the Production Window.

12. Click on Run Production.

The Run Window opens.

10-4
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13.

14.

15.

16.

17.

18.

19.

21

» A message box appears requesting you to “Clear the conveyor”.

Clear the conveyor.
Click on OK.

Click on Go.
»  The message “Waiting for aboard” will appear.

Place a Tutorial Board at the mouth of the conveyor.

Press the #3 TS-01 button to move the board to the dispensing station.
»  Dispensing will be performed.
»  When dispensing is complete, the red LED #4 on the TS-01 turns ON.

Press the #5 TS-01 button.

»  Theboard will either stop at the post-dispense zone, if thereis one, or exit the
machine entirely if thereis not.

» TheLED #2 on the TS-01 will turn ON.

Place another Tutorial Board (Side 2) at the mouth of the conveyor.
Press the #3 TS-01 button to move the second into the dispensing station.

Repeat Steps 15 - 21 until you have completed severa boards.

» Notice the Run Status information at the bottom of the Run Window. Itis
color-coded. Blue means “normal,” Yedlow means “warning,” and Red isan
“error.”

»  To stop the run, press Stop. The system will complete the current board and
stop.

»  To abort the run, press Abort. The system will complete the current part and exit
the program. Press the #5 TS-01 button to unload the board.

»  To pause the run, pressPause. The system will complete the current part and
pause. To resume the run, press Go.

This concludes the tutorial on Running Production.
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Shutdown

The Shutdown button in the Production Window does not shut down the dispensing system. It
allows the operator to perform a valve cleaning procedure or unload a board. To shutdown a

Production Run at any time, use the Run Control Buttons in the lower right corner of the Run
Window.

To shutdown the dispensing system, refer to the Start-up\Shutdown section of the Operation
Manual.
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area-fill: Digpensing lines of fluid
within a geometric pattern to
completely cover an area.

auer boat: A meta materid handling
plate used to transport parts into
automated systems.

Automatic Fiducial Locating
System: A vison system that finds
fiducias and compensates for small
changes on a workpiece during

dispensing.

Automove Control Language
(ACL): An Asymtek proprietary
motion control language consisting of
commands that control al components
of the dispensing system.

axis: X, Y or Z geometric dispensing
coordinates. See figure below.

beacon: A light pole generaly
mounted on the top of the dispensing
system which can act as a visual
indicator of system status by displaying
adifferent colored light for al possible
Status conditions.

CAD: Standsfor Computer Aided
Design.

camera offset: The cdibration of the
XYZ location of the camerawith the
crosshairs in the Vision System.

conveyor atom: A setof ACL
commands that controls the conveyor.

crosshairs: Two linesintersecting at
a90° angle in the center of the video
display on the computer monitor.

dispense head: The dispense head
is what moves during dispensing
operation. The valve, height sensor
and similar options attach to the
dispense head.

dispense zone: The part of the
dispensing area where dispensing is
actually performed.

dispenser control panel: The front
control pand on most dispensing
systems that has buttons for controlling
movement of the dispense head.

dispensing fluid reservoir: The
reservoir contains the dispensing fluid.
It may be a syringe.

dispensing runs (wet/dry): The
execution of a dispensing program
during which fluid is dispensed (wet) or
no fluid is dispensed (dry).

download memory: Information
downloaded from one system to
another.

electrostatic discharge (ESD): The
sudden transfer of eectricity from one
object to another.

fiducial: A distinct shape or object on
the board or part to be dispensed upon.
The vision system uses these objects
for location reference.
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flip chip: A die with solder bumps
which is placed die circuit side-down
on a PCB.

flip chip underfill: Dispensing lines
of fluid around the perimeter of aflip-
chip so that the fluid flows undernesth
the chip.

flow rate:  The amount of fluid in
milligrams per second that is flowing
from the vave.

gantry: A non-conveyorized
dispensing area on a hon-conveyorized
dispensing system.

heaters: Either contact or infrared
modules located between the conveyor
rails or ingde of the tooling plate (in the
pre-dispense, dispense and post
dispense areas of the dispensing
system). Used to heat parts during
dispensing and control the cure of the

€POXY.

height sensor: An instrument used
to locate the surface of the substrate to
determine its height and record the
information so the dispense tip can be
positioned at an exact distance above
the surface, ensuring consistent

dispensing.

home: The dispense head location
whose (X,Y,Z) location is defined as
(0,0,0). The default setting is where the
dispense head was located when the
system was first turned on.

icons: Smadl symbalic buttons used to
execute a menu shortcut.

[/O (Input/Output): Communicetion
between one component or device and
another.

JIT program: A Just-In-Time fluid
delivery schedule based on fluid shelf-
life. The scheduleisworked out with
the distributor to prevent over-stocking
so fluid shdlf-life does not expire
before it is used.

kPa: Air pressure measured in kilos
per square one thousand Pascals.

lead frame: A type of part handler
where multiple parts are imbedded in a
metal tape.

LED light: Light-Emitting-Diode.
The needle sensor has an LED
indicator light.

LLHC: Lower left hand corner.

load cell: A sensor located on Model
NSZ needle sensors that is used as a
touch point for substrate height
measurements. The needle sensor
probe touches down on the load cell
which records the value (Automatic
Height Sensor Cdlibration).

LRHC: Lower right hand corner.

Material Safety Data Sheet
(MSDS): Information for the safe
use of materials. Generdly included in
the fluid packaging.

message areas. InaWindows
program, these are areas or boxes that
contain information for the operator.

micro pots: Dispensing technique for
filling divots or voids on the substrate
or part.

mil: One thousandths on an inch, or 1
x 10° inches.

model window: An area defined
during the fiducial location process.
The model window encompasses the
fiducid.
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multipass pattern: A pattern that
re-uses one set of fiducials to repeat
the same pattern at one or more
locations on the workpiece.

needle sensor: An instrument used
to locate the position of the dispensing
tip in the X-Y-Z directions.

needle sensor substrate: A
ceramic pad placed on the needle
sensor and dispensed on during needle
location definition routines.

Non-recoverable interlock
condition: You must completely exit
the dispensing software program, re-
start the dispensing software and re-
open the program to continue.

Notepad: A Microsoft Windows
accessory software application that
can be used to read .TXT files, such as
the SPC files compiled during Event

Logging.

offset camera; Camerathat uses
crosshairs in the Vison System to
locate XY Z locations.

operator: A person running pre-
programmed dispensing systems and
performs routine maintenance.

outputs. Electrica signals to control
devices that must turn On and Off on
command.

pattern: A command or set of
commands that use fiducials for
dispensing lines, dots, €tc.

pixels: The smalest unit of graphical
data appearing on a computer monitor.
A pixd usudly consigts of color and
brightness information.

port: Any machine connection that
allows for the exchange of electrical
signds.

post-dispense zone: The part of the
dispensing area where a part is held
after it leaves the dispense zone and
before the part leaves the system. The
part may be heated in the post-
dispense zone, but no dispensing is
performed.

pot-life:  The period of time that an
epoxy is usable once thawed.

pre-dispense zone: The part of the
dispensing area where apart is held
before entering the dispense zone. The
part may be heated in the pre-dispense
zone, but no dispensing is performed.

process engineer: A technica level
position. The process engineer designs
and develops processes for automated
electronic packaging using production
line equipment.

production operator: A non-
technical level position. The production
operator monitors and operates pre-
programmed dispensing systems during
production runs and performs minor
routine maintenance.

purge station: A location on the
dispensing system where a suction is
gpplied to the needle tip forcing the
fluid to flow. A plastic cup insde of the
purge station catches the fluid.

scale: An eectronic scale usualy
located in the front lower cabinet of the
dispensing system. It is connected to
the software via serial communication
ports.

search window: An area defined
during the fiducia location process.
The search window isthe areaiin
which the Vison System will look for a
fiducid. The default value is equal to
the size of the computer screen.

Glossary - 3



SECS/GEM Interface: SEMI
Equipment Communication Standard
(SECS)/SEMI Generic Equipment
Model for Effective Factory
Automation (GEM). SECS/GEM isthe
protocol used in cases where several
factory equipment units are linking
together viaa Host Computer. The
GEM standard defines useful
conventions for designing the
communications interface on a unit of
factory equipment to improve
operations with a Host Compuiter.

SEMI: Semiconductor Equipment
and Materids International. An
organization which defines protocols
for the semiconductor industry.

serial communication ports: PC
ports designed to facilitate seria
communication between the PC and
another device.

service stations:. The Purge and
Weigh Stations on a dispensing system.

skew correction: The ability of the
software to adapt to a part not oriented
correctly on the workpiece.

SMEMA: Surface Mount Equipment
M anuf acturers Association.

statistical process control (SPC):
Machine performance data gathered
and stored in text files. You can
review SPC files to monitor system
performance.

substrate: Any surface, part or
element, usualy a PCB, that is being

dispensad upon.

substrate height: The substrate
height is a Z-axis vaue the dispensing
system assigns to the maximum
distance the dispense head must
descend before dispensing.

surface mount adhesive (SMA):
An adhesive used for attaching chips to
PCBs.

syringe: A cylindrical package of
fluid, typicdly plastic and containing 1-
50 cc of fluid. It looks similar to a
medica syringe.

teach: Entering and saving XYZ
locations.

terminal mode window: A window
or screen that allows you to type
commands for a particular device, such
as. Dispenser, Conveyor, Scale, etc.

toolbars: Accessory menus
containing icons for performing certain
actions.

TS-01 Interface Smulator: A small
Asymtek device used to smulate
conveyor communication between the
dispensing system and neighboring
material handling conveyors.

ULHC: Upper Left Hand Corner.

underfill:  The process of flowing
epoxy underneath aflip chip on a PCB
to completely sed the solder bumps.

URHC: Upper Right Hand Corner.

valve: A device used to control or
regulate the flow of materiad from a
pressurized reservoir, such asa
syringe. Vaves can be actuated by
several methods, such as air pressure,
augers, or solenoids.

valve conditioning fluid: A thick
blue fluid used to condition the inside of
dispensing valves.

video overlay: Thevideo image
from the camera placed inside a
Windows area.
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vision system: Includes the camera,
vision software and light source.

weigh station: A location on the
dispensing system where fluid is
dispensed into a cup and weighed for
volume.

weight-control line: A line whose
thickness is determined by the amount
of fluid weight it contains.

wor kpiece: An object to be
dispensed upon, such as a PCB, auer
boat or |eadframe.

X-axis. Left to right movement of the
dispense head in the dispensing area.

X/Y-axis. Two axes a right anglesto
each other.

Y-axis. Forward and backward
movement of the dispense head in the
dispensing area.

Z-axis. Up and down movement of
the dispense head in the dispensing
area.
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“A—

alarms, 4-8

Anafaze, 4-1

areafill, 8-21

Asymtek program group, 3-3

Asymtek Vision for Windows (AVW), 3-2
automatic back-ups, 2-3

Automove Control Language (ACL), 3-10

—B—

backtrack gap, 8-7
backtrack length, 8-8

CAD Import, 9-21
cadlibration, 3-2
camera, 6-7
caliper tool, 7-13
calipers
density, 7-16
sizing, 7-16
camera
caibration, 6-6
on/off, 3-13
video overlay, 3-2, 3-18
camera-offset, 3-1
camera-to-height sensor offset, 6-20
chip offset, 6-8, 9-3
chip tolerance, 3-2
Cognex, 7-5
commands, 3-13, 3-14, 3-15, 3-16, 7-1
configuration, 3-6, 6-1, 6-6
system, 6-1
conveyor, 6-1
cooling devices, 4-1
corner finder, 7-6, 7-12
corner finding, 3-1

defaults, 8-11, 8-16
dispense gap, 8-7, 8-12
dispensing
areafill, 8-21
commands, 3-15
control, 8-7, 8-12
speed, 8-7
wet/dry, 3-13
dispensing program, 3-12

dispensing system
setup, 3-1
dots
parameters, 8-12
down acceleration, 8-13

down speed, 8-8, 8-13

dwell, 8-7, 8-12

=
edge detection, 7-6, 7-12
encapsulation, 8-21
event log, 6-3, 6-5

—F—

fiducids, 6-23, 7-6
accept threshold, 7-10
confusion threshold, 7-10
corner finding, 3-1, 7-12
editing, 7-17
model fiducias, 7-6, 7-9
quality, 7-6, 7-13
recognition, 3-1, 7-6, 7-12
re-use, 9-2, 9-5
samples, 7-8
singlefiducia, 7-12, 7-14
skipping, 9-2
teaching, 7-9
filenames, 3-21, 6-5, 6-21
flow rate
calibration data, 3-2
fluid cooling devices, 4-1
fluids, 8-7
fluid files, 6-21, 6-24
fluid lot data, 3-2, 3-24, 6-21
fluid setup, 3-7, 3-21
FMW
starting, 3-5
FMWTools, 6-1, 6-2

gan, 7-11
gantry, 6-25
—H-

Heater Control. See also Heaters
Heater Control for Windows, 3-4
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heaters
controller, 4-2
heater control, 4-1
heater setup, 4-1
input offset, 4-6
loop names, 4-2, 4-3
manua mode, 4-3
needle heater, 4-1
output value, 4-3
set point, 4-3
temperature deviations, 4-8
thermocouple type, 4-6
time proportioning alarms, 4-8

height sensor, 3-2, 6-1, 6-10, 6-15, 9-5

height sensor micrometer, 6-12
-

1/0, 3-11
initialization, 3-2
installation, 1-1, 6-1, 6-6, 6-10, 6-15
Installation Package
Installation Guide, 2-1
Tutorial Board, 2-2
User Guide and Tutorid, 2-1

L

light levels, 3-1, 7-12

light source, 7-5

lines, 8-2
parameters, 8-10
weight control, 8-6, 9-3

M-

manual conventions, iii

master offsets, 6-10, 6-15
measurements, 6-3

menu commands, 3-16

menu restrictions, 6-4

mid-move 1 and mid-move 2, 8-13
multi shot delta, 8-13

multipass, 9-1, 9-14

—N—

needle heater, 4-1

needle sensor, 6-10, 6-15

needle setup, 6-11
needle-to-camera offset, 6-19
needle-to-height sensor offset, 6-17
Notepad, 6-5

number of shot, 8-13

—O-

offsets
Calculate Master Offsets, 6-6
camera-to-height sensor, 6-19
needle-to-camera, 6-18
needle-to-height sensor, 6-17
Valve Offsets, 6-6
on-vector mode/off-vector mode, 8-13
operator level, 6-3, 6-4
Orthogonality Tolerance, 7-12, 7-14

—P—

part skipping, 3-2
passwords, 6-3, 6-4
pattern placement, 7-3, 8-23, 9-1
patterns, 7-3, 8-22
pot life, 3-24, 6-21, 6-24
potting, 8-21
preferences, 6-1
pre-move delay factor, 8-7
procedures, 7-3
process commands, 3-13
production, 3-20, 3-24, 10-4
production lot tracking, 3-2
program commands, 3-14
program groups, 3-3
programming, 3-12, 7-1, 7-3, 9-1
areafill, 8-21
encapsulation, 8-21
lines, 8-1
multipass, 9-1, 9-16
underfill patterns, 9-4
weight control lines, 8-6
programming setup, 6-21, 6-23
projection length, 7-13
prompted setup, 10-4
purge station, 3-2, 6-17
purging, 6-24

R—

reticles, 6-8

retract acceleration, 8-8, 8-14
retract distance, 8-7, 8-14
retract speed, 8-8, 8-13

S

safe Z height, 6-10, 6-15, 6-18
scale, 3-10, 6-1

SECS/GEM interface, 3-6, 3-25, 5-1, 10-1

serial ports, 6-1
settling time, 8-13
setup
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dispensing system, 2-2, 3-7
heaters, 4-1
initial, 3-2, 6-1, 6-10, 6-15
Manual, 6-32
production, 3-2, 3-22, 6-1, 6-27, 10-4
programming, 6-21, 6-23
purge, 6-1
vision system, 6-6, 6-8
shutdown, 10-6
shut-off distance, 8-7
single fiducia, 7-12, 7-14
skew correction, 3-2
skip marks, 9-2
SMEMA, 10-1
software update, 6-10, 6-15
SPC datalog, 6-5
spirdl fill, 8-22
statistics, 3-2, 3-24
suckback, 8-8, 8-14
surface mount technology (SMT), 9-21
system configuration, 6-1, 6-2
system setup, 6-1

T—

temperature, 4-2
terminal communication, 3-10
thaw time, 3-24

timers, 9-1, 9-5

tool tips, 3-13

TS-01 Interface Simulator, 10-1
tutorial boards, 1-1, 7-4

—U—

underfill patterns, 9-4

V-

valve offsets, 6-15, 6-16

vave-on time, 8-12

vaves
changesto, 6-10, 6-15
control, 8-7, 8-12

video blaster, 7-5

vision calibration, 6-7

Vision for Windows, 7-5

vision system, 3-2, 3-4, 6-6, 7-5

“W-—

weigh station, 3-2, 6-17

weight-control lines, 8-6, 8-9, 9-2

workpiece alignment, 6-23
workpiece origin, 6-24
workpieces, 7-2
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